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Basic Navigation

Basic Navigation

Aspen is your school district’s student information platform. It contains all of your district’s student
information, such as grades, attendance, and schedules. It also contains information for your
district’s teachers, administrators, and administrative staff.

Use Aspen to view, enter, or edit student or staff information. First, you need some basic

knowledge of how the system is organized, how data is stored, and ways to navigate. You should
familiarize yourself with the following:

» Settings bar

« Tabs, side-tabs, and sub-tabs
. Menus

« Fields

« Fieldsets

« Breadcrumbs

5etti|-|s P e al Change View  Sealect School  Sat Preferences  Log Off

School View

Pages School de Staff Attendance Conduct  Grades Assessment Schedule Glebal  Admin

Options LS Help 7
Student List :: 11 - Adam, Monique /" <—— breadcrumbs record navigation bar *EEEE
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-+ ¥ 1
P— Demographics | [ [ [
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Transcript
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S5es55ments .
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Photo
varbery |
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Documents
Snapshots

Using the Settings Bar

EEDER o foamee | Change View  Select School — Set Preferences  Log Off
High School 2013-2014 B

. > School View

On the settings bar, you can do the following:

« Click Change View to change to the District, School, Staff, Health, Build, Special Education,
Personnel, Family, or Student view. You will not see the Change View option if you do not
have access to more than one view.
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« Click Set Preferences to set your user preferences when using Aspen. For example, you can
change your password or indicate that you want to be warned to save information when editing a
column on a list.

« Click Log Off to log off from the system. For security reasons, it is important to log off before
leaving your desk. Closing the browser window without first logging off from Aspen keeps the
user session open. To minimize security risks, always click Log Off before closing the browser
window.

Change Views

If you have access to more than one view, click Change View on the settings bar to change to a
different view from any page in Aspen.

Also, you can set a default view in your user preferences.

= . setting Change View  Select School  Set Preferences  Log Off
h Sctlool 2013-2014 < Sehool View

Some educators take on a number of different roles in a school system. For example, assume you
are logged on to the high school's system as a technology director. First, you need to define a new
user in the Admin tab. Then, since you are also a teacher, you need to access your gradebook for
your classes. To do so, you would need to change to the Staff view.

To change views

1. Onthe settings bar, click Change View. The Change View menu appears:

Special Education

Family

Student

2. Do one of the following:
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« Click District to access information for all students and staff members in the district and to
configure district settings.

« Click Intermediate Organization to access and view information for the students and staff
members in one specific organization and configure organization settings.

« Click School to access and view information for the students and staff members in one spe-
cific school in the district and to configure school settings.

« Click Staff to manage attendance and grades for your classes.
« Click Health to manage student health information for a school.
« Click Build to build a master schedule for your school.

« Click Special Education to track IEPs and other information for your special education stu-
dents across the district.

« Click Family, as a parent, to view all of your children's attendance, grade, and conduct
information.

« Click Student, as a student, to keep track of your assignments and activities and store files
in your virtual locker.

Note: An easy way to know which view you are in is by the color scheme — for
example, maroon and gold for the District view, and blue and green for the School view.

If you are working in one view, change to another, and then change back to the first view, the
system remembers the page you were previously working on. For example, assume you are
viewing a student’s transcript in the School view. Then, you change to the Build view. When you
change back to the School view, the student’s transcript you were originally viewing appears.

Change to Another School

If you are already logged on to a specific school within your district, do the following to change to
another school’s information:

1. Onthe settings bar, click Select School. The School Pick List lists the schools you can
access:
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7 orecards @
M= 0
@ Crows Faint High Schoal CFPHS
() |District Drist
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() |History School HIST
() |Horth Elementary Haorth
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) %2 Middle Schoal A

2. Select aschool, and click OK. Aspen displays the same tab and side-tab that you were pre-
viously viewing; however, if you were on a detail page, then you would be returned to the list
(since the list will contain all new records).

) 2013-2014

.'—*;_' S s T SrE
Pages | School Student  Staff Attendance Conduct Grades Assessment Schedule Global

Set Your User Preferences

You can configure a number of user preferences to make using Aspen faster and easier.

On the settings bar, click Set Preferences. The Set Preferences dialog box appears:
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General

Default locale US English

Default View School -
Default school Crow Point High School Q
Auto-save interval (minutes) 5

Dizable User-defined Help

List Options
Records per page 30
Show lower page controls W
Warn on save b

The Set Preferences dialog box for the Staff view contains five tabs:

« General

« Home

« Security

« Gradebook

« Communication

« Receipts (if your school uses receipts)

Set Your Preferences on the General tab:

1. Click the General tab.
2. Use the following table to fill in the fields:
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Field Description

Click this drop-down to select your language and date preferences
when using Aspen. This selection determines the language used on
Aspen's pages and online Help, and in user guides.

This selection also affects the display of dates in Aspen. If you
Default locale select:

« English Canada: Dates appear as date/month/year
« French Canada: Dates appear as year/month/date
« US English: Dates appear as month/date/year

Click this drop-down to select the default view you want you want to
Default View see when logging on to Aspen, such as the School view. (This option
is only available if you have access to more than one view.)

Click CL to select the default school you want to use when
Default school accessing the School view. (This option is only available if you have
access to more than one school.)

Type the number of minutes you want to lapse before the system
automatically saves the information you enter on a detail page. The
system displays a message to the right of Save and Cancel on detail

pages, alerting you of the time of the last auto-save, or why the auto-
Auto-save interval save failed.

(minutes)
I A A R R LIS ——S—S———Miaa——_—————

Note: If you move between sub-tabs of a detail page, the
countdown continues.

If your district creates and uses user-defined help, and you do not
want to view the user-defined help icon # for fields and templates,
select this checkbox.

Disable User-
defined Help

Type the number of rows you prefer on alist page. (Most users like to

Records per page see all rows on a page without having to scroll.)

1: Abbondanzio, dnthony t

&l at

Show lower page To display the page controls |
controls the bottom of all list pages, select this checkbox.

If you want the system to display a warning when you click Save on
Warn on save a list page after you have used the Modify List option, select this
checkbox.

3. Click OK to save your preferences.
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General Home Security Gradebook Communication
Anncuncements
Fawvorites
Student search
Student Address Changes
Web sites
Tasks
Reports
Calendar

miin faiooceia]

2. Select the areas you want to appear on your Home page.

3. Click OK.

Set Your Preferences on the Home tab:

1. Click the Home tab:
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General Home Security

Gradebook Communication

Announcements
Fawvorites
Student search
Student Address Changes
Web sites
Tasks
Reports
Calendar

2. Select the areas you want to appear on your Home page.

3. Click OK.

Set Your Preferences on the Security tab:

1. Click the Security tab:

General Home Security

Gradebook Communication

Primary email

Alternate email

Google Docs email

Security question

Security answer

Confirm answer

Security guestion for second password
Security answer for second password
Confirm answer

Password

Secondary Password

jsmithi@aspenschools.ong

jsmithi@gmail.com

What are the last 4 digits of your SSN¥

‘What city did your father grow up in®

LT
Change

Change

2. Use the following table to enter information in the fields:
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Field Description

Type your primary email address. The system sends your
password to this address if you click the 'l forgot my password'
link on the logon page.

Primary email

Click this drop-down to select the security question you want to
answer if you forget your password.

Security question

Type the answer to the security question.

Security answer

Type the security answer.

Confirm answer

Click Change to change your password.

Password

Security question
for secondary
password

Click this drop-down to select the security question you want to answer
if you forget your secondary password.

Security answer
for secondary Type the answer to the secondary password security question.
password
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Description
Confirm answer Type the security answer again.
Secondary Click Change to change your secondary password
password 9 gey Y P ’
3. Click OK.

Set Your Preferences on the Gradebook tab:

To set your preferences on the Gradebook tab:

1. Click the Gradebook tab:

General Home Security Gradebook Communication
Shade alternate lines
Track administratoer updates
Tab direction ACOss W
Show studies =
Enable gradebook features
Assignment column order Date due {sscending]
Show points in headers =
Show category names in headers
Publish assignment statistics
Show student alerts
Show course selection recommendation
Anchor averages |:|
Missing Assignments
Show missing column D
Count empty as missing D
Show unscored
Averages
Default weighting Categories only -
Decimals 2
Grade scale Q x
Semester cumulative average
Cumulative average D

-10-
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2. Use the following table tofill in the fields:

-11 -



Basic Navigation

Field Description

Shade alternate
lines

Track
administrator
updates

Tab direction

Show studies

Enable
gradebook
features

Assignment
column order

Show points in
headers

Show category
names in
headers

Publish
assignment
statistics

Show student
alerts

Show course
selection

recommendatio

n

Anchor
averages

Select this checkbox if you want the system to shade every other row
of your Grade Input page. Otherwise, deselect this checkbox.

Select this checkbox to have an Exclamation point appear next to
any grades a staff member in the office changes in the School view.

Select whether you want the Tab key to move you across a row or
down a column when you are entering grades on the Grade Input page.

Select this checkbox if you want courses with a category of Study to
appear in your gradebook.

Select this checkbox if you want to use the Grade Input page to enter
scores for assignments. If you do not select this checkbox, the
gradebook only displays post columns (Term 1, Term 2, etc.).

Select if you want assignments to appear in Date due (ascending),
Date due (descending), or Sequence number order on the Scores

page.

At the Default weighting field, if you select Total Points, you can
select the Show points in headers checkbox if you want to view the
number of total points in the column header of an assignment.

Select this checkbox to display the names of assignment categories in
the assignment headers.

Select this checkbox if you want low, median, and high assignment
scores to appear for parents and students when they view grades using
the Family and Student portals.

Select this checkbox to display alert icons next to student names.

Select this checkbox to display the Recommendation column on the
Scores page. Staff can only make recommendations during the date
range defined by the school.

Select this checkbox to left-align average columns on the Scores page.
This way, the averages always appear next to the student information,
and the assignments appear to the right:

-12-
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Field Description

Student Fields Grade Columns Term Statud
Dafauit Fisids v ] [~ = | ®En
1 2 3 4 Part HWIK
H H H H 10401 10/01
MName YOG Part HWH
100 pts. 100 pts.
Anower, Connor 2010 (83.0 83.0 T8 a9z
Carlucci, Christine 2010 |[74.0 5.0 a0 20
Fougere, Danislle 2010 870 530 92 88
French, Bianca 2010 (TF.O 83.0 38 28

If you create special codes that you enter for missing assignments,
select this checkbox to view the Missing column on the Scores page.

For each student, the Missing column displays the total number of
assignments you have entered those special codes for.

Show missing The values in this column might help you when determining students'
column final grades for the term.

If you selected the Show missing column checkbox, any
assignments that were due before today, and that you have not entered
scores for, are counted as missing.

Count empty as
missing

When selected, you will see all rubrics for the selected term for an
individual student, even if no grade is entered. If it is not selected, you
will only see the rubrics relevant to the term selected and with a grade

entered.
Show unscored

Default To indicate to the system how you calculate averages, do one of the
weighting following:

-13-
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Field Description

« Select Categories only if you want to weight categories only in your
gradebook. For example, assume you create three categories: Home-
work, Tests, and Quizzes. All homework assignments are worth the
same amount, as are all tests and quizzes. To determine student
term averages, Homework is worth 25% of the grade, Tests are
worth 50% of the final grade, and Quizzes are worth 25% of the final
grade.

« Select Category and assignments if you want to weight both cat-
egories and assignments within those categories. For example, a stu-
dent's homework average is worth 25% of the term grade, but each
homework within the category is weighted differently. For example,
you weight reading homework assignments 1, and intensive writing
homework assignments 3.

« Select Total points if you calculate averages by dividing the total
points a student earns by the total number of points possible. For
example, a student receives a 100, 90, and 80 for grades. The stu-
dent's average is 270/300=90.

« Select Category total points if you want to use total points for indi-
vidual assignments within categories that you weight. For example,
assume you have a Homework category. The homework average
counts as 25% of the student’s final grade. Within the Homework cat-
egory, you grade each individual assignment using points (HW 1 is
worth 10 points, HW 2 is worth 20 points).

Note: This value becomes the default average mode for the teacher.
Teachers can then assign a different average mode to different
course sections in the gradebook.

Type the number of decimal places you want the system to use for

Decimals
calculated averages.
Click Q to select the grade scale you want to use to calculate term
Grade scale averages. If you use a grade scale different than the district grade
scale, when you update post columns, the system translates the
grades to the district grade scale.
Select this checkbox to show semester running averages on your
Scores page. Aspen calculates semester running averages based on
Semester the assignment grades within each of the terms inside of it, not on the
cumulative average for each term.
average

Students and family can view this column in the Student and Family
views.

-14 -
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Field Description

Aspen uses the column header Semester # (for example, Semester 1)
for semester running average columns.

Select this checkbox to show an overall cumulative average on your
Scores page. The overall cumulative average includes all grades and
scores entered since the beginning of the class, regardless of term.
Aspen calculates the overall cumulative average using the average
mode specified in your gradebook.

Cumulative Aspen uses the column header Cumulative for the overall cumulative
average average.

3. Click OK.

To set your preferences on the Receipts tab (if your school uses receipts):

1. Click the Receipts tab:

General Home Security Gradebook Receipts Communication

Print attendance receipts
Show preview
Humber of copies 1

-15-



Basic Navigation

2. Select the Print attendance receipts checkbox if a receipt should print when attendance is
entered on the Office Input page.

3. Select the Show preview checkbox if a preview of the receipt should appear before it is sent to
the printer.

4. Type the number of copies you want to print.
5. Click OK.

Log Off

To keep your district, school, student, and staff information secure, you should log off from the
system when you leave your desk. To log off, click Log Off on the settings bar

Change View Set Prefar = Log off

On the Log On page, you can log on to the system when you return to your desk or when you need
to use the system again.

Closing your browser without first logging off does not log you out of Aspen. Technically, your
session is still active until your session times out, which is a preference set by your Aspen system
administrator.

When Your System Times Out

Your district or intermediate organization determines the number of minutes your session can be
idle before the system automatically logs you off. The system warns you with one minute left:

“four sessicn will expire in less than
cne minute. 5 6

Weuld you like to continue with your

— ON000

Click Continue to continue your session. Otherwise, your session expires, with the expiration time
listed. Click OK, and the Log On page appears.

-16-
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Enter Data into Fields

An Aspen page is comprised of fields which store particular information. A collection of fields is
called a record or table. Aspen contains over 300 tables. Every table has a set number of fields.

For example, the Student table is comprised of 254 fields: 27 of them are system-defined, and 227
are user-defined. Some system-defined fields on the Student table include:

o student's name
« student's address
« student's phone number

A field is comprised of two parts:

« field name
« entry field

First name * Daniel

Type of Fields

Aspen's fields can be one of the following general types:

Entry fields

Users enter data into these two types of entry fields:

« Required: The user must enter data in order to proceed and save the data entered on the page.
Required fields have a red asterisk * next to the name. If you define a user-defined field as
required, it will also display the red asterisk.

First name * Daniel

Note: Not all samples of pages and fields shown in Aspen's online help and user guides
show the red asterisk indicating a required field.

« Optional: The user is not required to enter data in order to proceed. User can enter data or leave
it blank.

Middle name Edward

Display-only fields

User cannot enter data into these two types of fields. These fields cannot be edited. They display
information.

-17 -
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« Calculated: The user does not enter data here. This field's data is derived from a formula
involving other fields. Aspen automatically determines the correct value. This is a display-only
field.

The GPA is an example of a calculated field.

« Read-only: The user does not enter data here. These fields are for displaying internal system
information that cannot be changed, such as the object identifier (OID), the system's internal
name for the field which is used when exporting, importing, and writing reports and templates.

Object identifier gcdColMame

Most fields have attributes associated with them which determines the type of data that can be
entered in the entry field. For example, fields can be numeric, textual, long text, or short text. These
are defined by system administrators in the Data Dictionary and references tables, which work
together to allow administrators to control what data is stored in fields and what type of data users
can enter.

Validate Address Format

When you enter an address in an address field, Aspen breaks down the components of the address
into multiple address fields so the display of the address is appropriate for the selected organization
orlocale (U.S., Europe, Japan, military, etc.).

If you do not know the correct format of an address, you can enter it into the address field and have
Aspen validate the format — verify that the text entered is in the correct format, and if it is not,
correct it.

System administrators define the address format for an organization in the general preferences. The
following table gives examples of a U.S. address and a German address and how Aspen parses
them into the appropriate fields:

-18-
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Address Address Sys-tem
field User enters... components validated for
P U.S. address
Street number 350
: Street name Lincoln
:-\ddress 333 350 Lincoln Street
Street

Street type
Address line
2

City Hingham
‘;‘ddress LS Hingham, MA 02043 State/Province MA

Postal Code 02043

Street name StrandstralRe
,1Address L) Strandstralle 4A Street number 4

Street letter A
Address field
2

Postal code 70174
‘:ddress field 20174 Stuttgart

City Stuttgart

Note: Validating an address verifies the format of the address. Validating does not verify
that the address is correct for the person, or that the address is valid for the town.

To validate the format of an address:
1. Atan address field, type the appropriate information for the address line.

2. Click the Validate Format button E] The Address Components dialog box appears:

-19-
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Address line 1 24 Morth Street WValidate

User validated []

Address components

Street number
Street prefix

Street pre direction
Street name

Street type

Street post direction

FieldCO001

3. The Address line 1 field displays the text as you entered it. In the Address components sec-
tion, the fields display how Aspen has validated the format and parsed the components into the
individual fields. Click Validate to ensure the address entered correctly. To manually enter the
components of the address into the individual fields or to override a system-validated address,
select the User validated checkbox and type the address in the fields below.

Note: When an address is user-validated, ! appears next to the address field.

4. Click OK.

Use Tabs, Side-Tabs, and Sub-tabs

Aspen is similar to afiling cabinet — it organizes folders of information with tabs, side-tabs, and sub-
tabs:

-20-
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settings bar ——» [ESIEUFCRIES
tabs

Set Preferences  Log Off

School View

igh School 2013-2014

o= s

School Student

Pages Staff Aftendance Conduct Grades Assessment Schedule Global  Admin

12
recerd navigation bar #EEE@

Options Reports Help

Student List :: 11 - Adam, Monique [\ +—— breadcrumbs

. sub-tabs
IDetaiIs de-tabs [etautt Templet v
N Demographics | Ll Ethnicity Alerts
Contacts
Aiendence el
Canduct Mt rame
: Last name * [2dam

Transcript

s

ounter
R | - e
ververr |
Transactions
Documents
Snapshots

The same tabs appear at the top of each page so that you can quickly access another folder of
information.

After you click a tab, side-tabs specific to that tab appear on the left side of the page.

Rich Text Editor

Aspen has a rich text editor that can be used for creating and editing Pages :

4 He e @O0 B0 & %% [ souce @
Font Bl A-Aa-iBryUulEExE EE AR =
4
=N

Use the following chart as a reference for using the rich text editor:

-21-
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Text Editor Tool Function

¥ Undo: Cancels the last action performed.

¥

Redo: Cancels an undo.

i Select all: Selects everything in the dialog box.

Remove Format: Removes any formatting (bold, italic, etc.) from
the selected text.

[4]

Templates: Opens a template in the editor.

=1 Print: Prints the text box.

Image: Inserts an image into the text box. You can either:

| « Copy and paste the URL of the image in the URL field, or

« Click Browse for Image to insert an image saved on your com-
puter.

Flash: Inserts a flash application into the text box.

= Table: Inserts a table into the text box.

= Insert Horizontal Line: Inserts a horizontal line into the text box.

0 Insert Special Character: Inserts a special character into the text
box.

Link: Inserts a hyperlink into the text box.

Unlink: Removes a hyperlink from the text box.

Superscript: Allows typing in superscript.

&
&
El Subscript: Allows typing in subscript.

Source: Allows viewing or editing the HTML of the text. Currently
not supported in Microsoft® Internet Explorer.

E| source

Maximize: Click to maximize the text box to fill your browser’s
screen. Click again to minimize the text box.
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Basic Navigation

Text Editor Tool Function

- Font: Changes the text’s font.
e Size: Changes the text’s size.
Text color: Changes the text’s color.
A Background color: Changes the text’s background color.
Bold: Changes text to bold.
I Italic: Italicizes text.
E Underline: Underlines text.

1— Insert/'remove numbered list: Inserts a numbered list. Click
again to remove a numbered list.

— Insert/Remove Bulleted List: Insert a bulleted list. Click again to
remove a bulleted list.

Decrease Indent: Decreases an indent.

Increase Indent: Increases an indent.

Left Justify: Formats the text with a left justification.

Center Justify: Formats the text with a center justification.

Right Justify: Formats the text with a right justification.

Block Justify: Formats the text with a block justification.

Collapse Toolbar: Collapses the rich text toolbar.

ECT [w] [u] [o] [ [i] []

Expand Toolbar: Expands the rich text toolbar.

Using Menus

For every tab, menus appear below the tab names:

-23-
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Pages District  Student Staff Attendance Conduct Grades Assessment Schedule BiobalY Tools  Admin Filtler  SortOrder QuickReport

Options Reports Help Y S eSS W &4 BE =

Field set QuickCharts  Dictionary

Depending on the page, a combination of the following menus appears:

« Options menu

» Reports menu
« Help menu

« Field Set menu

« Filtermenu

o Sort Order menu

o Quick Chart menu

Using the Options Menu

Use the Options menu to select, search for, filter, or perform actions on the records currently
appearing on the list page:

Pages Student  Visit Immunization

Cptions Feports Help

1: Pbety, Emily

MNa e

Abety, Emily

Adams, Josephine

The Options menu contains selections appropriate for the current page.

Standard options are:

» Modify List
« Mass Update
o Query

» Snapshots
« Show Selected

« Omit Selected
Additional options that might be on your menu include:

« Send Email
« Initiate Workflow
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Modify List

Use the Modify List option to quickly and easily edit text on a list page for any field that is
editable. This is especially useful when you need to change values for multiple records.

To use the Modify List option:

1. Gotoany list page, such as the Student List:

Pages School Student | Staff Attendance Conduct Grades  Assessment = Schedule Global

Options Y

Student List

Details | [ 1: Ackerman, James 0 of 760 selected £7 Primary Active Students
Contact: [] Name LASID SASID Grade Homeroom DOB EnrStatus Email 1
Contacts

[ |ackerman, Jemes 293479 1345564568 1 c107 8/119/1992 Active jeckerman@comcast.com
Attendance [ |acam. Monique Z06544 1302488211 11 E207 1/20/1893 Active madam@blueyonder.com
Conduct [ |adams, Tyler 287230 1652226004 12 D107 711001991 Adtive tlewis@worldmail.com

[ |#iderisio, Mingle 232039 1172991282 10 4 11/1311993 Adtive malderisio@eudars.com
Transcript

[ |#lien. Disna 208672 1129254645 09 E107 12/28/1993 Adtive com
Assessments [ |Alper, Hesther 248235 1082556420 11 c208 11/1511992 Active hslper@blusyonder. com
Schedule [ [amies, Elsine 244040 1204051281 12 5208 £/20/1891 Active epilla@hotmail.com

[] |Amico. Joseph 208214 1215430988 1 H201 11211993 Active jsmico@eudors.com
Membership

[] |Amico, Timathy 241287 1082645502 09 GYIMA 11141995 Active tamico@eudors.com
Transactions [] |Andersan, 1sabella 283480 1260305854 09 B105 5121995 Active ipost@earthlink com
TrErTIT [ |andemsen, Lee 260887 1208268062 10 D112 2/24/1594 Active Ivenkatesh@earthlink. com

[ |andermsen, Mergarst 236301 1395487850 1 c108 6/20/1992 Active manderson@comeast.com
Snapshots

[ |andermen, Rese 255284 1188397751 12 c108 5131992 Active com

2. From the Options menu, click Modify List. A Pencil s appears below the names of fields
that can be edited:

Pages School Student Staff Attendance Conduct Grades Assessment Schedule Global

Options
Student List
Details <| | 1: Adverman, James 0 of 760 selected (7 Primary Active Students
2 LASID SASID Grade Homeroom DOB Email 1
Contacts [ Name # " Vi s EnrStatus r
Attendance [ |Akerman, James 232279 1245564589 11 c1a7 8/12/1992 Adtive jackermsn@eomeast. com
Conduct D \Adam, Monique 1208544 1302499311 11 E207 1/20/1993 Active madam@blueyonder. com
Conduc
D \Adams, Tyler 1297230 18522268004 12 D107 7110/1991 Active tiewis@worldmail com
TI’SI"IECI’\D[ D ‘Alderisic, Mingle 1232039 1172991282 10 4 114131993 Active malderisic@eudora.com
Assessments [] #ii=n, Diana 208872 1129254845 o9 E107 12126/1993 Active dsllen@acl.com
D \Alper, Heather |248235 1082556430 11 c208 114151993 Active halper@blueyonder.com
Schedule
[ |Amico, Elsine 244040 1204051284 12 8208 8/20/1591 Adive =pills@hotmsil.com
Membership [ |Amice, Jossph 205312 1215430988 11 H201 11211893 Adive iamico@eudora.com
Transactions [ |Amico, Timothy 241287 |1082845502 LE] EYMA 111411995 Adive tamico@euders.com
[ |Andersen, lsabella 282430 1280205654 LE] 8105 5121595 Adive ipast@earthlink.com
Documents
[ |Anderson. Lee l2e0e87  |1208206082 10 D114 2/24/1854 Adive Ivenkstesh@earthlink.com
Snapshots [] |Anderson. Margaret 1228201 1285437850 11 c108 €/20/1992 Active manderson@comoast. com

3. Click # inthe column containing the text you want to edit. Two new icons replace the pencil in
the selected column:
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Homeroom
Vv ®

40 |QUrdi.I'u1

3 | Qﬁnyne. i

4. Do one of the following:

« Select a checkbox to change its value to "yes," or deselect it to change its value to "no".
« Use the drop-down to select the desired value.
« Type avalue in the blank field.

5. Repeat Step 4 for as many records as you need to modify.

6. When you have finished making your modifications, at the top of the column:

o Click I to save all of your changes. If you don't do this before moving to a new page, all of
your changes will be lost.

e Click ® to discard all of your changes and leave the values in the column as they were.

Mass Update

Use the Mass Update option to permanently change one set of values to another set of values for

the same field. For example, maybe all of the students in Homeroom 101 are being switched to
Homeroom 14.

It is possible to mass update a field with another field or an expression. For those, you need to
perform an Advanced Mass Update.

To use the Mass Update option:

1. Gotoany list page, such as the Student List:
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Pages School Student | Staff Attendance Conduct  Grades  Assessment | Schedule Global

Options Repol Y

Student List

Details | [ 1: Ackerman, James ¥ 0 of 760 selected £7 Primary Active Students
Contact: [] Name LASID SASID Grade Homeroom DOB EnrStatus Email 1
Contacts

[ |ackerman, Jamas 293479 1345684569 1 c107 8191992 Active jsckermsn@comecast.com
Attendance [ |adam. Monique 208544 1302498311 1 E207 112011993 Adtive madam@blusysnder com
Conduct [ |adams, Tyler 287230 1652226004 12 D107 711001991 Adtive tlewis@worldmail.com

[ |#iderisio, Mingle 232039 1172991282 10 4 11/1311993 Adtive maldorisio@eudors.com
Transcript

[ |#l1en. Disna 208672 1129254645 09 E107 12/28/1993 Active dsllen@sol.com
Assessments [ |Alper. Heather 245225 1082556420 11 c206 11/15/1892 Active halper@blueyonder.com
Schedule [] |Amico, Elaine 244040 1304051281 12 5206 8i20/1991 Active i il.com

[] |Amico. Joseph 208214 1215430988 1 H201 11211993 Active jsmico@eudors.com
Membership

[ |Amico, Timathy 241287 1062645502 09 GYMA 1/14/1995 Active temico@eudors.com
Transactions [ |andersen, lssbella 283450 1260305854 09 B105 5(12/1995 Active ipest@earthlink com
TrrrTIT [ |andemen, Les 260887 1208268062 10 D112 2/24/1594 Active Ivenkatesh@earthlink. com

[ |andermsen, Mergarst 236301 1395487850 1 c108 6/20/1992 Active manderson@comeast.com
Snapshots

= [ |andermen, Rese 255284 1188397751 12 c108 513/1992 Active renderson@eudera.com

Select the records you want to mass update by doing one of the following:

« Select their checkboxes and then from the Options menu, select Show Selected.
« Useaquery.
« Useasnapshot.

From the Options menu, click Mass Update. The Mass Update dialog box appears:

Field R

Value | |

Gonce

Use the Field drop-down to select the field whose value you want to replace, such as Home-
room.

Type or select the Value to replace the existing value. For yes/no fields, such as Include in
Honor Roll, a checkbox appears. Select the checkbox to indicate a value of true or yes.
Deselect the checkbox to indicate a value of false or no.

Click Update.
The system confirms the field and value that you selected. Click OK or Cancel.

If you clicked OK, the system confirms the number of records that will be affected and asks if
you want to continue. Click OK to complete the mass update or Cancel to cancel the operation.
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Advanced Mass Update with an Expression

Use an advanced mass update when you need to permanently update a field with an expression.
Doing so can reduce your workload. For example, one advanced mass update can produce the
same results as two queries and two simple mass updates. Expressions also permit updates that
simply aren’t available any other way.

An expression is a string that can contain a mix of variable and literal tokens. Variable tokens are
enclosed in braces ('{' and'}') and contain a period-delimited string of accessors (accessors are
referenced by the Java name, which can be found in the Data Dictionary). A variable token might
also contain a function and parameters for that function. Literal tokens are any portions of the
expression that are not variable tokens. The following is an example of an expression:

{person.lastName}, {person.firstName}
This expression could be parsed into the following list of tokens:

1. VariableToken: "person.lastName"
2. LiteralToken: ™, "
3. VariableToken: "person.firstName"

The final result might be a value like "Doe, John".

To use the Advanced Mass Update option:

1. Gotoany list page, such as the Student List:

Pages School Student ™ Staff Attendance Conduct Grades  Assessment = Schedule Global
Options Reports Help Y

Student List

Details < | 1: Adkerman, James v | 0 of 760 selected /7 Primary Active Students
- []|Name LASID SASID Grade Homeroom DOB EnrStatus Email 1
Col 5

[ |Ackerman, James 293479 1345664569 1 c107 [8/19/1892 Active isckerman@comeast.com
Attendance [] |adam. Menique 208544 1202488211 11 E207 /2001993 Active rmadam@blueyonder. com
Conduct [] |Adams, Tyler 297230 1852226004 12 D107 71101981 Active tlewis@worldmail.com

[ |Adorisio, Mingle 232039 1172891282 10 4 11/13/1993 Active maldorisio@eudors. com

[ |alten. Disna 208672 1128254845 09 E107 12/26/1993 Active dsllen@sol.com

[ |Alper, Hesther 248235 1082558430 1 ca06 11/15/1993 Active halper@blueyonder.com
Schedule [ [Amico, Elsine 244040 1304051381 12 B206 16/20/1991 Active epilla@hotmail.com

[ [amico, Joseph 205314 1215430988 1 H201 /211993 Active ismico@eudors.com
Membership

[ |amico, Timothy 241387 1082845502 09 GYMA 1/14/1995 Active tamico@eudors.com
Transactions [] |anderson, Isat=lls 282490 1280205854 09 B105 5/12/1995 Active com
TrErTE [ |anderson, Le= 280887 12082686062 10 D112 [2/24/1994 Active Ivenkstesh@esrthlink.com

[ |anderson, Margarst 238301 1395487850 1 c108 le/20/1992 Active manderson@eomeast.com
Snapshots

[[] |anderson, Rase 255284 1128387751 12 c108 521952 Active randerson@eudors. com

2. Select the records you want to mass update by doing one of the following:
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« Select their checkboxes and then from the Options menu, select Show Selected.

« Useaquery.
» Use asnapshot.

100 of 750 selected (2 |

3. From the Options menu, click Mass Update. The Mass Update dialog box appears:

4.

® N o o

10.
11.

Field R

Value | |

(cpsete ] (Cenest]

Click Advanced. The Mass Update dialog box expands:

Field | |
e
Value | |
Force save |:|
| Updste || cancsl | | simpls |

Use the Field drop-down to select the field whose value you want to replace.
Use the Source drop-down to select An expression.
In the Value field, enter an expression of literal and/or variable tokens.

Select the Force save checkbox to override the validation of required or restricted fields during
the mass update process. If you don’t select this checkbox and a record has validation errors,
then it will not be saved.

Click Update. The system confirms the field and value that you selected.
Click OK or Cancel.

If you clicked OK, the system confirms the number of records that will be affected and asks if
you want to continue. Click OK to complete the mass update or Cancel to cancel the operation.
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Simple Examples

« Topopulate a new, user-defined field on the Student table so that it holds every student’s full
name in the format "First Middle Last” (for the purposes of running a Quick Report or customizing
labels, for example), use the following syntax in the Expression box:

{person.firstName} {person.middleName} {person.lastName}

« A school has just completed construction on a new wing. All current room numbers need to be
prefixed with the letter 'A’ to indicate the A wing:

A{roomNumber} (the value for room number is appended to

the literal 'A'")

Variable Token Functions

Variable tokens can also include functions to manipulate the resulting value. Functions are
delimited with parentheses followed by a list of arguments. The supported functions are outlined in
the following tables:

Function UPPER(fieldName)
Description This function converts all letters in a string to lowercase.
Parameters fieldName — the accessor to evaluate

From the Student List you could use this expression to convert all middle names
to lower case:

Example {LOWER (person.middleName)}

The name Charles would become charles.
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Function UPPER(fieldName)
Description This function converts all letters in a string to uppercase.
Parameters fieldName — the accessor to evaluate

From the Student List you could use this expression to convert all middle
names to upper case:

Example {UPPER (person.middleName)}

The name Charles would become CHARLES.

Function PROPER(fieldName, allWords)

This function converts the first letter of a word to uppercase and the remaining

REScUpasy letters to lowercase.
fieldName — the accessor to evaluate
Parameters allWords — either true or false. If true then all words in the value will be
capitalized. If false then only the first word will be.
From the Course List you could use this expression to convert all course
names to proper case:
{PROPER (description, true)}
The course name INTRODUCTION TO PHOTOGRAPHY would become
Example

Introduction To Photography.
{PROPER (description, false)}

The course name INTRODUCTION TO PHOTOGRAPHY would become
Introduction to photography.
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Function PADL(fieldname, length, ‘padCharacter’)

Describtion This function adds enough pad characters to the left of the string (a prefix) to
P reach the specified length. This is typically used for alignment purposes.

fieldName — the accessor to evaluate

Parameters length — the final, padded length of the string

padCharacter — the single character used for padding, this value must be
wrapped in single quotes (e.g., ' ' or'0')

From the Student List you could use this expression to right-align grade
levels:

{PADL(gradelLevel, 2,'0’)}
Before:

7

Example

After:
07
08
09
10
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PADR(fieldname, length, ’

Description

Parameters

Example

This function adds enough pad characters to the right of the string (a suffix)
to reach the specified length. This is typically used for alignment purposes.

fieldName — the accessor to evaluate
length —the final, padded length of the string

padCharacter — the single character used for padding, this value must be
wrapped in single quotes (e.g., ' ' or'0')

From the Course List you could use this expression to align course
numbers and descriptions:

{PADR(number,5,’ )} {description}

Before:

123 Cooking 101
1750 Chemistry
24689 History

After:
123 Cooking 101
1750 Chemistry

24689 History
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Function IF(fieldName, operator, ’

This function represents a conditional evaluation. If the condition evaluates

Description to true then one value is output; otherwise, the other value is output.
fieldName — the accessor to evaluate
operator — one of the following values:
equals
equalslgnoreCase
notEqualTo
notEqualTolgnoreCase
Parameters contains
beginsWith
endsWith
isEmpty
comparedValue — the test value used for comparisons, this value must be
wrapped in single quotes
trueResult — the resulting value if the condition evaluates to true
falseResult — the resulting value if the condition evaluates to false
From the Student List you could use this expression to set calendar codes:
Example
{IF(gradeLevel,equals,’12’,’Senior’,’'Standard’)}
Show Selected

Use the Show Selected option to narrow down the group of records you need to view or work with
just this one time.

Use Show Selected when you only need to keep a small portion of the records you are currently
viewing. Use Omit Selected when you only need to remove a small portion of the records you are
currently viewing.

To return to viewing the entire list, click the Filter menu J/ and click All Records.

To use the 'Show Selected' option:

1. Gotoany list page, such as the Student List:
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Pages

Options

Student List

Details
Contacts
Attendance
Conduct
Transcript

A me
Schedule
Membership
Transactions
Documen

Snapshots

School

Student ™ Staff

Reports

Attendance

Conduct

Grades = Assessment

Schedule

Basic Navigation

Global

=| [ 1: Ackerman, James 0 of 760 selected (7 Primary Active Students
[] Name LASID SASID Grade Homeroom DOB EnrStatus Email 1

[ |ackerman, Jamas 293479 1345684569 1 c107 8191992 Active jsckermsn@comecast.com
[ |adam. Monique 208544 1302499311 1 E207 112011993 Adtive madam@blusyonder.com
[ |adams, Tyler 287230 1652226004 12 D107 711001991 Adtive tlewis@worldmail.com
[ |#iderisio, Mingle 232039 1172991282 10 4 11/1311993 Adtive maldorisio@eudors.com
[ |#l1en. Disna 208672 1129254645 09 E107 12/28/1993 Active dsllen@sol.com

[ |Alper. Heather 248235 1082556430 1 G208 11/15/1993 Active halper@blusyonder.com
[] |Amico, Elaine 244040 1304051281 12 5206 8i20/1991 Active il.com

[] |Amico. Joseph 208214 1215430988 1 H201 11211993 Active jsmico@eudors.com

[ |Amico, Timathy 241287 1062645502 09 GYMA 1/14/1995 Active temico@eudors.com

[ |andersen, lssbella 283450 1260305854 09 B105 5(12/1995 Active ipest@earthlink com

[ |andemen, Les 260887 1208268062 10 D112 2/24/1594 Active Ivenkatesh@earthlink. com
[ |andermsen, Mergarst 236301 1395487850 1 c108 6/20/1992 Active manderson@comeast.com
[ |andermen, Rese 255284 1188397751 12 c108 513/1992 Active renderson@eudors.com

Pages
Options

Student List

Details
Contacts
Attendance
Conduct

Transcript

Schedule
Membership
Transactions
Documents

Snapshots

School

Student ' Staff

Reports

Attendance

Conduct

Grades  Assessment

Schedule

Global

(Custom Selection)

[] Name LASID SASID Grade Homeroom DOB EnrStatus Email 1 a

[ |storupka, Radiy 243858 1015018177 12 c284 8141982 Active

[ |Gildea, Anne 244172 1086262222 (5] M115 772411995 Active aabrsham@hotmail.com
[ |Lersen, Atisna 238452 1319837174 11 B105 €/28/1993 Active samold@comeast.com
[ |galvic. Aaron 212884 1252179011 10 201 8/27/1994 Active abalbio@acl.com

[ |ceteeys, Angy 279898 1103234720 12 intermn 181992 Active sbarstts@msn.cam

[ |smith. Aaran 292980 1347765249 10 LABS 1781994 Active barman@msn.com

[ keert, Alice 288058 1229048414 (5] 5208 41811995 Active sbarmashi@comeast.com
[] |weng. Anthony 286512 1381658801 (5] 4208 1/21/1985 Active sbarthley@topics.com
[ Besrdon, Andrew 212841 1071210016 (5] 208 10211884 Active sbesrden@yshoo.com
[ |Bessi, Ann 200852 1357434880 11 D107 /51583 Active sbossi@msn.com

[ |Powell, Ashiey 289793 1321650544 11 Lags 3/23/11993 Active sbucnepane@worldmail.com
[ |Butke. Alan 223418 1228801816 03 D101 10/14/1894 Active sburke@webfoot.com

The system displays only the records you selected. Notice that the text below the icons
displays Custom Selection to alert you that you are viewing a list of students you filtered.
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Omit Selected

Use the Omit Selected option to narrow down the group of records you need to view or work with
just this one time.

Use Omit Selected when you only need to remove a small portion of the records you are currently
viewing. Use Show Selected when you only need to keep a small portion of the records you are
currently viewing.

To return to viewing the entire list, click the Filter menu ? and click All Records.

To use the 'Omit Selected’ option:

1. Gotoany list page, such as the Student List:

Pages School Student ™ Staff Attendance Conduct Grades  Assessment = Schedule Global

Reports Help
Student List

Details < [1: Aderman, James | 0 of 760 selected (7 Primary Active Students
. []|Name LASID SASID Grade Homeroom DOB EnrStatus Email 1

[ |Ackerman. James 283478 1245584585 1 c107 8181982 Adtive jadermen@comaest.com
Attendance [] |adam. Menique 208544 1202488211 11 E207 /2001993 Active rmadam@blueyonder. com
Conduct [ [adams, Tyler 287230 1852226004 12 D107 7101981 Adtive tlewis@worldmail.com

[ [Aiderisic. Mingle 222038 1172881282 10 4 111211882 Adtive maldorisio@eudore.com
Transcript [] [Allen. Diana 208672 |1128254845 03 E107 12/26/1992 Adtive dallen@sol.com
Asse [ |Alper, Hesther 245225 1082558420 11 c208 11/15/1892 Active halper@blueyonder.com
Schedule [ |amice, Elgine 244040 1204051381 12 B208 /2011991 Adtive =pills@hotmsil.com

[ |amico, Joseph 205314 1215480888 1 H201 121853 Adtive jamice@eudora.com
Membership

D \Amico, Timothy 241387 1082845502 a9 GYMA 1/14/1995 Active tamico@eudors. com
Transactions [] |anderson, Isat=lls 282420 1280205854 09 B105 5/12/1995 Active com
Documents D |Anderson, Lee 260887 1208288082 10 0114 |2/24/1994 Active Ivenkatesh@earthlink com

D |Anderson, Margaret 238301 1295487850 1 G108 |8/20/1992 Active manderson@comcast. com
Sﬂath(’l‘E D |Anderson, Rose 265264 1188387761 12 G108 5/3/1992 Active randerson@eudors. com

40 of 760 selected 7

3. From the Options menu, click Omit Selected:
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Pages School Student | Staff Attendance Conduct  Grades  Assessment | Schedule Global

Options Reports
Student List

Details = | 1: Adkerman, James v| 0 of 720 selected (7 Custom Selection
Contacis [] Name LASID SASID Grade Homeroom DOB EnrStatus Email 1

[ |ackerman, Jamas 293479 1345684569 1 c107 8191992 Active jsckermsn@comecast.com
Attendance [ |adam. Monique 208544 1302498311 1 E207 112011993 Adtive madam@blusysnder com
Conduct [ |adams, Tyler 287230 1652226004 12 D107 711001991 Adtive tlewis@worldmail.com

[ |#iderisio, Mingle 232039 1172991282 10 4 11/1311993 Adtive maldorisio@eudors.com
Transcript

[ |#l1en. Disna 208672 1129254645 09 E107 12/28/1993 Active dsllen@sol.com

[ |Alper. Heather 248235 1082556430 1 G208 11/15/1993 Active halper@blusyonder.com
Schedule [] |Amico, Elaine 244040 1304051281 12 5206 8i20/1991 Active i il.com

[] |Amico. Joseph 208214 1215430988 1 H201 11211993 Active jsmico@eudors.com
Membership

[ |Amico, Timathy 241287 1062645502 09 GYMA 1/14/1995 Active temico@eudors.com
Transactions [ |andersen, lssbella 283450 1260305854 09 B105 5(12/1995 Active ipest@earthlink com
TrrrTIT [ |andemen, Les 260887 1208268062 10 D112 2/24/1594 Active Ivenkatesh@earthlink. com

[ |andermsen, Mergarst 236301 1395487850 1 c108 6/20/1992 Active manderson@comeast.com
Snapshots [ |andermen, Rese 255284 1188397751 12 c108 513/1992 Active renderson@eudors.com

The system displays all of the records, except for the ones you selected. Notice that the text
below the icons displays Custom Selection to alert you that you are viewing a list of students
you filtered.

Send Email

Whenever you are on a person-based list in Aspen, such as the Student List or Staff List, you can
send:

« amass email to everyone on the list
« anemail to a selected group on the list
« anemail to one person on the list

Note that you can also send reminders, announcements, and alerts via text using the free Follett
Notifications app.

To send an email from a person-based list:

1. Go tothelist containing the records of the people you want to send the email message to.

2. From the Options menu, click Send Email. The Mass Email dialog box appears:
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3. Use the following table tofill in the fields:
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Field Description
From This address is the primary email address listed in your user preferences.
To The names of the recipients who will receive the message appear.

Use these checkboxes to select or deselect students, their first emergency
contacts, and their teachers as recipients of the email.

Students
Contacts
Teachers
Subject Type a subject for your email message.
Attachment If yo!J want to attach afile to your message, click Browse to navigate to
the file you want to send.
Type your message inside the text box. A rich text editor provides the
following formatting options:
o Font
« Fontsize
« Formatting, including bold and italics, bullets and numbering
Text box

o Color

« Hyperlinks and images

4. Click Send. Aspen asks if you are sure that you want to send this message.
5. Click Yes or No. If you click yes, a progress meter appears.

View History of Changes to a Field

With the appropriate user role privileges, you can view the history of changes to a field on a detail
page.
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To view the change history:

1. On the detail page, go to the Options menu and select Change History.

2. Click the drop-down to select one of the following to view the change history of fields on the
detail page from:

Today
Yesterday
This week
Last week
This month
All records

3. After viewing the history, click Close.

Initiate a Workflow

There are several ways to initiate a workflow. Access workflows in whatever method is most
efficient for you.

« From the Tasks widget on your Home or other Pages
« From the Special Education view
« From the Options menu

To initiate a workflow from the Options menu:

1. Log on to the Staff view

2. Go tothe Options menu, and select Initiate Workflow. The Initiate Workflow wizard displays
Step 1.

3. Select the workflow you want to begin.

Example

If you are reporting a conduct incident, select the Conduct Referral workflow.

4. Type the date or click EH to select the date.

5. Click Next. The wizard displays Step 2.
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6. Click Next. The wizard displays Step 3.

7. Confirm the information, and click Finish. The workflow now appears in the Tasks area for any
user who is listed as a participant in the next phase of the workflow.

Using the Reports Menu

Use the Reports menu to run reports associated with the current page:

Pages School Student | Staff Attendance Conduct

Grades  Assessment  Schedule Global

Options Reports Hulp Y = _ H

=
sttt L [<J<Ial>]>]
\
Details 0 of 1 selected &7 All Records
c EmergPri Address Relation=hip Phonel Phone2? Portalsccess
I Detail D 1 |Abreham, Ellen 18 Gamiscn Temace Parents 781-T41-9187 508-221-8238 Al

The Reports menu options change on every page. For example, the Reports menu on the
Student tab’s Contacts side-tab contains Student Contacts. If you click the Enrollment side-tab,
Quick Report is the only Reports menu option.

Enter Parameters When Running Reports

When you run reports in Aspen, you view them on-screen before you send them to a printer. This
way, you can verify that the report contains the data you want in the appropriate format.

To enter parameters when running reports:

1. Afteryou click a report name on the Reports menu, the dialog box for that report appears.

2. Type the date range for the report, or click the calendars to select the dates.
3. Select how you want the report to sort the results.
4. Select one of the following report formats:

« Adobe Acrobat (PDF)

« Web Page (HTML)

« Microsoft Excel (XLS)

« Comma-separated values (CSV)

5. Click Run. The system displays the report in the format you select.
6. Check the results of the report. Then, print it.

Using Quick Reports/Quick Print

Use the Quick Print menu on list pages to quickly create reports to capture information about the
list of records you are viewing in a printable format:
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Pages District School Student Staff = Grades |DASSESSMEREY Schedule Global Tools

Options. Reports Help

Document Structures

. - = S 0 of 26 selected &7 All Ref
Definition [7] |Hame Description

Assessment [T atex

History [T |BE Header

—— [0 [BC Lesson Structure

[ |BE Topic Structure

Using the Quick Print menu, you can create two types of reports:

« A Quick Print, which is a Simple Quick Report that instantly prints the list of records you are
viewing in a formatted report.

To generate a Simple Quick Report (known as a Quick Print), click the Printer icon. Select an
output format, such as Web Page (HTML), and your Quick Print appears:

Student List - All Active Students
Name SASID LASID H1N1 | EnrStatus | Grade | Homeroom | HR Teacher | DOB Email 1
Ackerman, James | 1345564569 | 293479 N Active 11 c107 Wilsan, A 8/19/1992 | jackerman@comcast com
Adam, Monique 1302499311 | 206544 N Active 11 E207 Deang, C 1/20/1993 | madam@blueyonder com
Adams, Tyler 1652226004 | 297230 N Active 12 D105 Baker, A 7101991 |tadams@gmail com
Aldorisio, Mingle 1172991282 | 232039 N Active 10 D103 Baum, H 11/13/1993 | maldorisio@eudaora.com
Allen, Diana 1128254645 | 208672 N Active 09 E107 Sjolie, E 12/26/1993 | dallen@acol.com
Alper, Heather 1062556430 | 248235 N Active ! E101 Weisz, J 11/15/1993 | halper@blueyonder. com
Amico, Elaine 1304051361 | 244040 N Active 12 B205 Ambrose, A | 6/20/1991 | epilla@haotmail. com
Amico, Joseph 1215480988 | 205314 N Active 1 A101 Medwar, D | 1/2/1993 jamico@eudora.com
Amico, Timothy 1062645502 | 241387 N Active 09 E201 Brandy, H 1/14/1995 |tamico@eudora com
Anderson, Isabella | 1260305854 | 283490 N Active 09 B105 Bowers, J | 5/M12/1995 |ipost@earthlink com
Anderson, Lee 1208266062 | 260687 N Active 10 D104 Holland, K | 2/24/1994 | venkatesh@earthlink com
Anderson, Margaret | 1395487850 | 236301 N Active " D201 Liu, K 6/20/1992 | manderson@comcast com
Anderson, Rose 1188397751 | 255264 N Active 12 D201 Liu, K 5311982 randerson@eudora.com
Anderson, Taylor 1038939046 | 231707 N Active 10 A204 Barr, D 1/18/1994 |thoulgate@aaol.com
Anderson, Zachary | 1360247593 | 213726 N Active 10 E102 Wilson, A 11/28/1993 | Zzimsong@webfoof.com
Antuna, Erika 1330258775 272189 N Active 1 M101 Gordon, J 11/24/1992 | gjolicoeur@earthlink.com
Arakelian, Andrew | 1090613445 | 254713 N Active 10 B205 Ambrose, A | 11/17/1993 | agannaway@webfoof.com
Arakelian, James 1048595505 | 210338 N Active 09 E207 Deang, C 5/20/1995 | jarakelian@msn com

« A Quick Report, which is an on-the-fly report of the information you are viewing on a list page.
You decide what's on it, and the system formats it to look professional.

There are four types of Quick Reports:

« Simple: Produces a list of the records and fields you select to include

« Detail: Produces a page for each record, and the report aligns the data fields vertically instead of
horizontally

« Group: Groups records by the fields you select, such as homeroom
« Summary: Hides individual records from the list and produces a list of cumulative values based
on the records

To create a Quick Report, click the Printer icon, and click Create Quick Report. The Quick
Report wizard appears and walks you through the steps of creating the report you need.
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Generate a Quick Print Using the Printer Icon

You can generate a Quick Print using the Quick Printicon ﬂ in the menu bar on any list page.
Clicking this icon once is the same as going to the Options menu, clicking Quick Report, and
selecting the Simple report type.

Or, to create a different type of Quick Report, click the Quick Printicon and then select Create
Quick Report to go directly to the Quick Report wizard.

To generate a Quick Print using the Quick Printicon:

1. Gotothelist page containing the type of data you want to report on.
2. Select the records you want to include on the report.
3. Onthe Options menu, click Show Selected.

0 of 553 selected 7

4. Click the Quick Printicon 5 in the menu bar. The menu expands:

= 1=

I

5. Click one of the following format options:

« Web Page (HTML): to view the information in an HTML file.

« CSV:toview the information in a text file that separates each field with a comma. If saved,
the file will have a .CSV extension

« TXT: to view the information in a text file that separates each field with a comma. If saved,
the file will have a . TXT extension.

6. Microsoft Word (DOC): to view the information in a Word document. The data appears in a
table, which has all the available options for borders and shading.

7. To print the report, do one of the following:
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« From your browser window or dialog box, go to File > Print.

([¥n )
« From Microsoft Word, click the Office Button @ and then click Print.

To generate a detail, summary, or group Quick Report using the Quick Print icon:

Go to the list page containing the type of data you want to report on.
Select the records you want to include on the report.
On the Options menu, click Show Selected.

A wbd =

Click the Quick Printicon ﬁ in the menu bar. The menu expands:

5. Click Create Quick Reportto open the Quick Report wizard.

Generate a Quick Report Using the Reports Menu

Use a Quick Report to create an on-the-fly report of the information you are viewing on a list page.
You decide what's on it, and the system formats it to look professional.

If there is a particular report that you run every week, such as an attendance report, creating and
saving a Quick Report means that you only have to set up the formatting once. Then, every time
you run the report it will look the way you want it to.

For example, maybe you like to shade every other line for easier reading and set up the report to pull
statistics such as boy totals and girl totals per attendance category. If you save your Quick Report
and run it each week, the formatting will look the same, but the information on the report will vary
based on the data in the system.

Other users in your school and district can create and share Quick Reports. Before creating your
own Quick Report, you might want to check the saved reports to see if it already exists.

Before starting to create your Quick Report, get your list page (such as the Student List) showing
the fields and records that you want to include. This minimizes the setup time in the Quick Report
wizard.

0 of 763 selected 7

The Quick Report wizard contains eight steps, but only the first four are required. The others let you
customize the report's format and design. If you prefer, you can do the formatting in Excel.
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To generate a Quick Report from the Reports menu:

On the Reports menu, click Quick Report. The Quick Report wizard appears:

Quick Report: Source Step 1 0of 8
Source
@) Mew report
Saved report
| <Bacc | [ mext> Finizh | [ Cancel

The Quick Report wizard has eight steps:

Step 1: Source

1. Do one of the following to determine if you want to create a new Quick Report or use one that's

been saved:

« Select New report to create a new report.

« Select Saved report to use a report you or another user previously created. The page dis-
plays a list of the reports available to you. You can click Finish to immediately print the

report without making any changes.

2. Click Next.
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Step 2: Report Type

ist format. Pidk your columns and sort order, add
statistics, and run.

1. Click the Report type drop-down to select the type of report you want to run:
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Type Description

0000000 J‘_”
3
T
D

Group
[ N

The Simple Quick Report produces a list of the records and fields you
select to include. You select the columns and sort order. You can also
add totals or statistics, which appear in a summary table below the list of
records.

Example: The school nurse wants a list of all eleventh and twelfth
graders sorted by grade level, then homeroom.

The Detail Quick Report produces a page for each record, and the report
aligns the data fields vertically instead of horizontally.

For example, when running a Detail Quick Report on a student-based list,
each student record appears on a separate page, with the fields you
select as the rows.

Example: A new guidance counselor is starting and would like a list of his
students with basic demographic information, as well as a photo, to put in
each student's profile folder. Plus, he wants to know how many boys and
girls he's been assigned.

The Group Quick Report groups records by the fields you select. For
example, on a Student List you can group records by homeroom.

After you select Group, Step 3 displays the fields available to group
records by. Then, on Step 5, you can include page breaks as well as
calculate totals by group. For example, use Group Quick Reports to print
homeroom or bus lists.

Example: The new school year is starting, and you need to pull together
homeroom lists for the homeroom teachers that also show the number of
students in each room.
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Type Description

The Summary Quick Report hides individual records from the list and
produces a list of cumulative values based on the records.

Summary Use this report to print totals and other statistical reports.

After you select Summary, Step 3 displays the fields available to produce
values for. Then, on Step 5, you can include page breaks, as well as
calculate totals.

Example: The principal would like to know, for each course, how many
sections are offered and what is the average enroliment for the course.

2. Click Next.

Step 3: Field Selection

Quick Report: Field Selection Step 3 of 8
Available Fields | Sort A-Z Selected Fields
v Name
Identifier ~| Local identifier
Photo = State identifier
Last name E E:.de level
First name meroom
Middle name Date of birth
Name Enrcliment status
i Frimary email
Title 2 < Remove
Address

Suffix

Local identifier

< Badk MNeat = Finish Cancel
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1. Select the fields you want to include on the report and the order you want them to appear in.

2. Highlight afield in the Available Fields column, then click Add to add the field to the Selected
Fields column. To select several fields next to each other, press SHIFT and the Up or Down
arrow on your keyboard to select the fields. To select several fields together that do not appear
next to each other, press CTRL while you click each field you want to include.

To remove a field from the Selected Fields column, highlight it, and click Remove.

3. Click Next.

Step 4: Sort Order
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Quick Report: Sort Order

Step 4 of 8

Available Fields [ Sort A-Z

Student

Selected Fields

w

Identifier
Photo

Last name
First name
Middle name
Title

Address

Suffix

Local identifier
Gender

State identifier
Date of birth

“ear of graduaticn
Grade level

=

Name

< Badk Mext =

Finish Cancel

. To determine how the system sorts the overall report, such as which records print first, do the fol-

lowing:

In the Available Fields column, highlight the field you want the system to use to sort the report

by, and click Add to move the field to the Selected Fields column. You can continue to select
fields and add them below the primary sort.

In the Selected Fields column, highlight the fields and click Up and Down to determine the sort
order (the field that appears first in the column is the primary sort, then the secondary sort, and

soon).

Click Next to continue with setting up grouping and formatting options (optional). Or, click Finish

to run your report.
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1.

2.

3.

Basic Navigation

Quick Report: Totals and Statistics Step 5of8
Totals
Group Total Count Page Break
Crverall I:‘
Year of graduation
Statistics
Field Function Reset By
Home language | MAX » | | Group: Year of graduation W | x
Name | MAX b | | Group: Year of graduation | | ﬂ
[Fron] (e}

In the Totals section, to include totals of records on the report, select the Total Count check-

box next to the group.

In the Statistics section, for each field you include on the report, the report can provide the min-
imum, maximum, and total count of each field. For example, click the drop-down to select
Gender, click Add, and select COUNT to see totals of boys and girls. You can also track field
averages and sums for numeric fields. Following any statistic selection, if you have selected
group by fields, specify exactly when you want that statistic to reset. By default, the statistic
will be reset only at the end of the report. If a group field is chosen, the value will be reset at the
end of that grouping, allowing you to view group-based statistics.

You can add several statistics and resets for each field.

Click Next.
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Step 6: Format Options

Quick Report: Format Options Step6of8

Header

Report title c PA Report

Print date
Body

Format .:'\“.ft—b Fage [HTML) V|

Font face _:Arial v_.

Font size I'1‘_'—d|urr| V

Grid lines [ I.-!:.l.i.z:}ntal E\\-’E"tl cal v

Shade alternate lines

1. Use the following table to enter information in the fields:
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Field Description

Report title Type a title for the report.

Select the Print date checkbox if you want the report to print the current

Print date date.

Select one of the following:

+« Web Page (HTML) to view the information in an HTML file.

« Comma-separated values (CSV) to print the information in a text file
that separates each field with a comma. The file will be saved with a
.CSV extension.

« Comma-separated values (TXT) to print the information in a text file that
Format separates each field with a comma. The file will be saved witha . TXT
extension.

Font face Select the font you want the report to print in.
Font size Select the font size of the report.
Grid lines Select the type of grid lines (vertical, horizontal, or both), if any.
Shade . . .
Select this checkbox if you want the report to shade every other line for
alternate S
. easier viewing.
lines
2. Click Next.
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Step 7: Field Format Options

Quick Report: Field Format Options Step70f 8
Custom Width
Humber of characters. I:l
—
Fontice
Font e
Bold o
Italic O
Underline O
[ <Back | Next= i B Finien I cance: .

1. Foreach field that displays on the report (the columns of information that appear), you can define
a custom width in number of characters, and specific font and text effects.

2. Click Next.
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Step 8: Save Options

Quick Report: Save Options Step8of8

Save Dptions

Q Don't save

() Save

() Saveas

Name |GPA Report
Owner
Type User v_'

Hame Administrator, System Q

1. Use the following table to enter information in the fields:

Field Description

Select one of the following in the Save Options box:

« Select Don’t save if you do not want to save the report para-
meters you just selected. When you click Finish, if you like
the report that appears, you will have to go through the wizard

Save Options again to recreate it.

» Select Save to save any changes you made to an existing
saved report.

« Select Save as to save the parameters you entered as a new
Quick Report.

If you selected Save as, type a name for the report (this is the

> Elul) report's file name, not its title).

Select the type of report (User, School, Intermediate
Owner Type Organization, or District). The options available to you depend
on the view you are logged into and your privileges.

Owner Name Click ""1 to change the name of the report's owner.

2. Click Finish. The report displays the information in the format you selected.

-55-



Basic Navigation

Use Quick Letters

Use the Quick Letters feature to quickly create and customize attendance, conduct, or grade-
related letters from any student list page for students meeting a given set of criteria. You can then
print these letters as one print job and mail them to the students or their parents/guardians.

For instance, you might use Quick Letters to create a custom form letter regarding students who
have five or more absences so far this semester. The letter would notify parents that their students
are in danger of losing course credit. You could also use this feature to create a more general letter
for all students informing them of the school attendance policy.

To create a Quick Letter, click the Quick Letter icon J on any student list page and complete
the Quick Letter wizard. For instructions on completing the Quick Letter wizard, see the "Create a
Quick Letter" Help topic.

Create a Quick Letter

On any student list page, click the Quick Letter icon J to access the following options:

« Create Quick Letter: Brings up the Quick Letter wizard, which lets you customize your Quick
Letter in detail and access saved letters.

« Attendance: Brings up a streamlined version of the Quick Letter wizard that begins on the input
page for an attendance-related letter.

« Conduct: Brings up a streamlined version of the Quick Letter wizard that begins on the input
page for a conduct-related letter.

« Grades: Brings up a streamlined version of the Quick Letter wizard that begins on the input page
for a grades-related letter.

Note: You can access the student list page by clicking the Student tab while logged on to the
District, Intermediate Organization, or School view.

To create a Quick Letter:

On any student list page, click J and select Create Quick Letter. The six-step Quick Letter
wizard appears:
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Quick Letter: Source Step 1 of 6

Source

& MNew letter

Saved letter

= Badk Mesxt = Finish Cancel

Step 1: Source

Do one of the following:

o New letter: Select this option to create a Quick Letter from scratch. Then click Next.

« Saved letter: Select this option to either resend a saved Quick Letter or use it as the basis
for a new letter. A table of saved Quick Letters appears. Select the letter you want to re-cre-
ate or use as a basis for a new letter. Then either click Next to skip to Step 3 and customize
your letter, or click Finish to re-create the letter without any changes.
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Step 2: Letter Type

Quick Letter: Letter Type Step 2 of 6

Letter Type Quick Letter - Attendance ¥

= Back Mesxt = Fini

1. Click the Letter Type drop-down to select the type of Quick Letter you want to create:
« Quick Letter — Attendance: Creates a letter for students who meet certain attendance cri-
teria, such as having four or more absences in the past month.

« Quick Letter — Conduct: Creates a letter for students who meet certain conduct criteria,
such as having more than one suspension in the semester so far.

« Quick Letter — Grades: Creates a letter for students who meet certain grades criteria, such
as having a GPA less than or equal to 2.0.

2. Click Next.
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Step 3: Input

Quick Letter: Input Step 3 of 6
Organization Follett Schools
School Crow Point High Scheool

CET
TR
Students to include
Search value I:l

Exclude
Code Ressons Dperator Valus Conneclor
. . =fce Desmm =gl —EuE sed oo
1st criteria ==
i * Absences | v v oo o And ¥
section Tardies | M oo O And ¥
e Dismissals v ¥ oo g And ¥
| v v ¥ Joo And ¥
2nd criteria * [~ v v oo And ¥
section | v v ¥ oo And ¥
| v R ¥ oo

= Back Mesxt = Finish Cancel

1. Use the following table to enter information in the fields:
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Field Description

Start date Type the start date of the date range you want to search for
(Attendance and attendance records or conduct incidents within, or click B and
Conduct letters only) select it from the pop-up.

End date Type the end date of the date range you want to search for
(Attendance and attendance records or conduct incidents within, or click EH and

Conduct letters only) ~ Select it from the pop-up.

Click Q . The Transcript Definition Pick List appears. Select the
transcript definition used by the school that the students you want
to create a Quick Letter for attend. The fields of this transcript
(Grades letters only) definition become the criteria that you can choose from when
determining which students to create the letter for. Click OK.

Transcript
Definition

To further limit the set of students who meet your Quick Letter's
criteria, select one of the following options:

« Current selection: Only includes students within the current fil-
ter on the student list page.

« YOG: Only includes students who have a specific year of gradu-
ation. You can specify the YOG at the “Search value” field.

Students to include

« Snapshot: Only includes students who are part of a specific
saved snapshot. You can specify the snapshot at the “Search
value” field.

If you selected YOG or Snapshot at the “Students to include” field,
Search value type the specific YOG or snapshot name you want to restrict your
search to.

Criteria

« The 1st criteria section includes a selection of preset, common attendance
codes (for attendance-related letters) or conduct record types (for conduct-
related letters) that you can use as criteria for your letter.

« The 2nd criteria section lets you select other attendance codes or additional
instances of conduct record types as criteria from drop-downs.

Note: Grades-related letters do not have a 1st criteria section, since the transcript definition
fields you use as criteria vary depending on the transcript definition you select.

Code To include other attendance codes in your criteria than those listed
by default in the 1st criteria section — Absences, Tardies, and

(Attendance letters Dismissals — select those codes from the drop-downs in the 2nd

only) criteria section.

Type To include more instances of the conduct record types listed by
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Field Description

(Conduct letters
only)

Fields

(Grades letters only)

Reasons

(Attendance letters
only)

Code

Operator

Value

default in the 1st criteria section — Incidents and Actions — in your
letter’s criteria, select those types from the drop-downs in the 2nd
criteria section.

For example, you might want to create a Quick Letter for students
who have either more than one suspension or more than four
detentions in a date range. In this case, you would need to have
two Incidents rows, one for suspensions and one for detentions.

Click the drop-downs to select the transcript definition fields you
want to use as criteria.

To restrict your criteria to include only students who have an
attendance code paired with a specific reason, select the reason
from the drop-down.

For example, to create a Quick Letter for students who had
absences due to illness, in the Absences row, select Sick (or
another value) from the Reasons drop-down.

To restrict your criteria to include only students with a specific type
of conduct incident or action, select the appropriate code from the
drop-down.

To restrict your criteria to include only students with a certain
number or range of attendance codes, conduct records, or grades-
related criteria, select the appropriate numerical operator from the
drop-down.

For example, to create a Quick Letter for students who had one or
more suspensions in a date range, you would select Greater than
or equal to as an operator and type 1 in the Value field.

Note: If you leave the Operator and Value fields blank, the letter's
criteria will include all students who have any value in their
student record for the attendance code, conduct record type, or
transcript definition field defined in that row.

For example, say you want to create a generic letter to all
students detailing the school’s attendance policy. You could
create an attendance-related Quick Letter, and leave the Operator
and Value fields blank in the Absences, Tardies, and Dismissals
rows. This would include students who have any value, including
none, for those fields in their attendance records.

If you selected an operator to restrict your criteria to include only
students with a certain number or range of attendance codes,
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Field Description

conduct records, or grades-related criteria, type the value modified
by that operator.
Exclude excused Select this checkbox to exclude from your criteria any instances of

(Attendance letters that row’s attendance code that were excused by a teacher or staff

only) member.
To include multiple criteria, select one of the following connector
options from the drop-down:

Connector « And: Searches for students who satisfy both the criterion defined

in that row and the criterion defined in the next row.

« Or: Searches for students who satisfy either the criterion defined
in that row or the next row.

2. Do one of the following:

« Click Next to customize the header for your Quick Letter.

« Click Finish to create the letter using the default or saved header, body text, and options set-
tings.

Step 4: Create Header

Quick Letter: Create Header Step 4 of 6

HE B MLOR E|= = = == HE || 3= 3= || [ Source || 23

Arial - || 12 - || Format - A-B-|B I U|| x x*||T,

Follett Schools

Attendance Letter
Jul 29, 2014

body table tbody tr td V|

= Back MNext = Finish Cancel
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Customize the header that appears on your letter using a modified version of Aspen’s rich text
editor. For instructions on using the additional tools included in the modified editor, see Step 5.

When creating a letter, certain information appears in the header by default. Your district name is
displayed in the header’s top-left corner, the school name in the top-right (if you are creating a
Quick Letter at the school level), the date in the bottom-right, and the letter type in the center. To
customize the default header, do the following:

1. Make your modifications using the rich text editor.

Note: For more information on using Aspen’s rich text editor, see the “Using the Rich
Text Editor” Help topic.

2. Do one of the following:

» Click Next to customize your Quick Letter’s body text.
« Click Finish to create the letter using the default or saved body text and options settings.

Step 5: Create Letter

Quick Letter: Create Letter

Step 5 of 6
EH HWdO R == = — P — s |22 2| [ source || 52
Font » || Size ~ || Format - A-B- | B I U| x, x*| T,
A
< Badk Mext = Finish Cancel

1. Type the body text for your Quick Letter using a modified version of Aspen’s rich text editor.

In addition to the standard text and media editing tools, the modified rich text editor provides

three additional tools designed for Quick Letters. Use the following table as a reference for
using these tools:
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Function

Field: Use this tool to insert a field, such as “Student name,” into the text box.
When you complete the Quick Letter wizard, this field is populated with the
appropriate information for each student.

Toinsert afield in your Quick Letter, click the icon. The Add Field pop-up appears:

Add Field b1

Student v

15t Time 9th Grade

504 last end date

504 status

8th Gr 1st day room

ACT GE 20 Ind

AM Bus route

AN Shuttle

Abarginal Ancestry

Abariginal Status

Academic Program -

OK C I
ance »

Click the drop-down to select the appropriate table for your field. For instance, if
you want to add a field for the student’s State/Province, you would select the
Physical Address table. The pick list refreshes to display all fields in that table.
Select the appropriate field, and click OK.

Note: Table and field names are determined by your Aspen system
administrator, and might differ from those shown.

Expression: Use this tool to insert an expression into the text box. Expressions
are variables that call and display information from the student record of each
student included in the letter’s criteria. They can also be modified by filters that
alter their output.

For example, you could use this tool to insert an expression in your letter's body
text that displays a pronoun (‘He” or “She”) based on the gender code in the
student record.

Toinsert an expression in your Quick Letter, click the icon. The Add Expression
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Function

pop-up appears:

Add Expression x

Expression Input

|

|
OK Cancel
Bl oo |,

Type the expression in the Expression Input field, and click OK.

Calculation: Use this tool to insert a predetermined calculation, such as the
student’s total number of suspensions, into the text box. When you complete the
Quick Letter wizard, Aspen evaluates this calculation for each student included in
the letter’s criteria.

Toinsert a calculation into your Quick Letter, click the icon. The Add Calculation
pop-up appears:
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Function

Add Calculation X

Total # of absences -
Total # of tardies

Total # of dismissals

Total # of unexcused absences

Total # of unexcused dismissals

Total # of other codes

Cancel
| concer |

Select the appropriate calculation from the pick list, and click OK.

2. When you are finished customizing your Quick Letter's body text, do one of the following:

« Click Next to adjust the letter’s options.
« Click Finish to create the letter using the default or saved options settings.
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Step 6: Options

Quick Letter: Options Step 6 of 6
Options
Don't save
Save
®) Save as
Name
Owner
Type School T
Name Gary Caks Secondary SD 72 Q
= Back et = Finish Cancel

1. Inthe Options section, select one of the following:

» Don’t save: Aspen does not save the letter. This is the default setting.

« Save: Aspen saves the letter using previously-provided name and owner information. This
option is only available when customizing a previously-saved Quick Letter.

« Save as: Aspen saves the letter using the name and owner information you provide in Step
2.

2. If you selected “Save as”, use the following table to fill in the letter's name and owner inform-
ation:
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Field Description

Name Type a file name for the letter.
Owner

Click this drop-down to select one of the following, depending on your
user privileges:
« User: Gives a user or yourself access to the letter.
Type « School: Gives users at a school access to the letter.

« Intermediate Organization: Gives all users in an intermediate
organization access to the letter.

« District: Gives all users in the district access to the letter.

Click Q . A pop-up lists the organizations or users you selected in
Name the Type field that you have access to. Select a specific owner for the
letter, and click OK.

3. Click Finish. The letter appears.
Using the Filter Menu

Use the Filter menu ? to determine the group of records that appears on the page, such as all
active students.

In the upper-right corner of each page, click ? and select Manage Filters to do the following:

« Addanew filter

« Change the order of filters
- Edit afilter

« Copy an existing filter

« Delete afilter

]
Pages School Student ™ Staff Attendance Conduct Grades @ Assessment Schedule Global

Options Reports Help

Manage &
Student List Primary Adlive Students
Former Studenis
Details [7: Ditomassi, Alexander ¥ 0 of 723 selected &7 Mext Year Students Custom Selection
Last Name Begins With 2
Last name First name Middle name ID LASID = oG Grade
Contacts 4] Active SPED Students
[ piternassi Alexsnder Robert [237-48-5284 218179 |INOG=2 2011 10
Attendance [ |pitemassi Treulich 084-15.2515 z0ssqe | All Adtive Studens 2008 12
1 student per Phone, Address
Conduct [ |penshue Stephanie Syndhis 005-79-56681 (287850 |G [ 2012 09
. [ |penste Thomas [244-168-9471 284528 1300742165 2011 10
Transcript
[ |pennetly Cory 167-17-4081 220888 1512751617 2012 hE]
Assessments [ |pencvan Jake 138-20-3224 235390 1584819771 2011 10
Schedule [ |pooks Allejandro ames 480-87-2973 223772 1169431690 2012 09
: [ |poocks Chittur 146-18-3474 299997 1389637198 2010 1
Membership
[ |pocks Corey Dougles 108-08-1018 224558 1801974727 2011 10
Transactions [ |peoks Pater Carl 375-31-8842 1271824 1835483288 12008 12
i [ |perer Issbelle 156-01-4028 (289277 1088117227 2009 12
[ |poubex Liliz He'Nieos 453-41-1783 241088 1422126779 2012 09
Snapshots
[]|poucet (Arthur Robert |253-88-2898 212337 1148033781 2010 1
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Add a Filter

The Filter menu ? contains a number of default options, such as all active students. You can
add your own options to this menu using queries or snapshots that have already been created.

To add a filter to the Filter menu:
1. Gotoalist page, such as the Student List.

2. Inthe upper-right corner of the page, click the Filter icon ? and then select Manage Filters:

The Manage Filters dialog box appears:

Manage Filters

ANl Active Students [System]
Primary Active Students [System)
All Primary Students [Systemn)]
All Secondary Students [Systemn)
Former Students [System]

Mext Year Students [Systern]
Begins with a [User)

All Students [System]

Active SPED Students [User]

EI:
i

Show/Hide Show All

[ Mew | [ Edit| | Copy | | Datete |

3. Toadd anew filter, click New. The Filter Pick List appears:
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Name 1 student per Phone, Address

Charner Administrator, Joe L

Filter Type Saved Query W
1: 1 student per Phone, Address w 28 records ¢/
Hame OwnerType

G} 1 student per Phone, Address District

) [2010 YOG User

() |Active SPED Students District

{:} Begins with a User

{:} Counselor = Mr. Jones School

{:} Counselor = Mr. Owens School

{7 |Counselor = Ms. Adler School

{7 |Counselor = Ms. Farker School

{:} Counselor = Ms. Reyes School

(") [Female 10th Grade User

Type a Name for the new filter.

Click the Owner drop-down to select who will be given access to the filter.

Click the Filter Type drop-down to select Saved Query or Snapshot.

Select the query or snapshot you want to add to your Filter menu.

Click OK. Your query or snapshot is added to the bottom of the list of your filters:

® N o ok
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Manage Filters

All Active Students [System]
Primary Active Students [System]
All Primary Students [Systemn]
All Secondary Students [Systern]
Former Students [Systemn)

Next Year Students [System]
Begins with a [User]
All Students [System)
Active SPED Students [User]
| Counselor Mr Reynolds [User]

R—

[new | [Edit] | copy | | Delete |

Close

9. Click Close.

Change the Order of Existing Filters

You can change the order of the filters on your filter list. The top item on the list is your default filter
for the page.

To streamline your list, you can hide filters that you do not use frequently. This keeps your access
to them, but removes them from your favorites list. You can also remove filters from the Manage
Filters dialog box.
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favorites list

Manage Filters

Al Active Students [System]
Primary Active Students [Systemn]
All Primary Students [System)]
All Secondary Students [Systern]
Former Students [System]

Next “ear Students [Systemn]
Begins with a [User]

All Students [System]

Active SPED Students [User]

ShowiHide Show All

(v (5] (Cor] (o]

Close

Manage Filters dialog box

To change the position of any filter on the list:

1. Click the Filter icon ? and then select Manage Filters:

The Manage Filters dialog box appears:
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Manage Filters

LAl Active Students [Systemn]
Primary Active Students [System)]
All Primary Students [Systemn]
All Secondary Students [Systemn)
Former Students [System)

Mext Year Students [Systemn)
Begins with a [User]

All Students [System)
Active SPED Students [User)

Show/Hide Show All

[NE‘-.'.'] [Edit] [E::-p@.-'] [ Delste ]

2. Select afilter to highlight it. Click the Up or Down button until the filter is in the desired position.
The top filter on the list is your default filter for the page.

3. Usethe following table to learn how to hide and display filters:
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Favorites list

1. From the Manage Filters dialog box, click the filter to highlight it.
2. Click Show/Hide. The filter displays in parentheses and is grayed
out.

To hid
o hide a 3. Close the dialog box.

filter

Note: When you click the Filter icon, that filter does not appear.

1. From the Manage Filters dialog box, click the hidden filter to high-
light it.

. Click Show/Hide. The parentheses are removed, and the filter is
no longer grayed out.

3. Close the dialog box.

4. Click the Filter icon to view the filter in your favorites list.

To display 2
a hidden
filter

Manage Filters dialog box

1. From the Manage Filters dialog box, click the filter to highlight it.

To hide a 2. Click Show/Hide.The filter displays in parentheses and is grayed
filter out.

3. Deselect the Show All checkbox to hide the filter completely.

To display 1. From the Manage Filters dialog box, select the Show All check-
a hidden box. The hidden filter displays in parentheses and is grayed out.
filter 2. Todisplay it completely, highlight it and click Show/Hide.

4. Click Close.

Edit a Filter You Own

You can edit a filter that you own, but you can not edit a filter that is owned by another user. The
edits you make to afilter apply to all users who have access toit.

To edit another user's filter that you have access to, first copy it, then edit it.

Note: You might not have security privileges to edit a school- or district-owned filter. See your
Aspen system administrator for more information.

To edit a filter you own:
1. Gotoalist page, such as the Student List.

2. Inthe upper-right corner of the page, click the Filter icon J/ and then select Manage Filters:
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The Manage Filters dialog box appears:

Manage Filters

CRIT Adive Students [Systemi
Frimary Active Students [System]
All Primary Students [System]

All Secondary Students [System]
Former Students [System]

Mast Year Students [System]
Begins with & [Liser)

All Students [System]

Active SPED Students [Usar]

3. Select the filter to highlight it, and click Edit. The Filter Pick List appears:
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Hame 1 student per Phone, Address

Owner Administrator, Jos L'

Filter Type Saved Query |
1: 1 student per Phone, Address W 28 records (7
Name OwnerType

@ 1 student per Phone, Address Dristrict

) (2010 YO User

{3 |Active SPED Students District

() |Begins with a User
Counselor = Mr. Jones School
Counselor = Mr. Owens School

{:} Counselor = Ms. Adler School

{:) Counselor = Ms. Parker School
Counselor = Ms. Reyes School

O Femasale 10th Grade User

4. Make changes to the Name, Owner, and Filter Type fields as needed.
5. Click OK.
6. If needed, change the order of a filter by selecting it and then clicking Up or Down:

Manage Filters

All Active Students [System)]
Primary Active Students [System)]
All Primary Students [System)
All Secondary Students [System]
Former Students [Systemn]

MNext “ear Students [Systemn)
Begins with a [User]

&Il Students [System]

Active SPED Students [User]

Counselor Mr Reynolds [ser)

Show/Hide Show All

[NE‘-.'.'] [Edit] [Eup}'] [ DEIEtE]

Close
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7. Click Close.

Copy a Filter
You can copy any filter, whether you own it or not.
To copy afilter:

1. Gotoalist page, such as the Student List.

2. Inthe upper-right corner of the page, click the Filter icon ? and then select Manage Filters:

The Manage Filters dialog box appears:

Manage Filters

(Al Active Students [System]
Primary Active Students [System]
All Primary Students [Systemn)]
All Secondary Students [System)
Former Students [System)

Mext Year Students [Systern]
Begins with a [User)

All Students [System]

Active SPED Students [User]

El:
i)

Show/Hide Show All

[ Mew | [ Edit| | copy | | Delete |

3. Select the filter to highlight it, and click Copy. The Filter Pick List appears:
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Name 1 student per Phone, Address

Charner Administrator, Joe L

Filter Type Saved Query W
1: 1 student per Phone, Address w 28 records ¢/
Hame OwnerType

G} 1 student per Phone, Address District

) [2010 YOG User

() |Active SPED Students District

{:} Begins with a User

{:} Counselor = Mr. Jones School

{:} Counselor = Mr. Owens School

{7 |Counselor = Ms. Adler School

{:} Counselor = Ms. Parker School

{:} Counselor = Ms. Reyes School

{:} Female 10th Grade User

4. Make changes to the Name, Owner, and Filter Type fields as needed.
5. Click Save.
6. If needed, change the order of a filter by selecting it and then clicking Up or Down:
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Manage Filters

All Active Students [System]
Primary Active Students [System]
All Primary Students [Systemn]
All Secondary Students [Systern]
Former Students [Systemn)

Next Year Students [System]
Begins with a [User]

All Students [System)
Active SPED Students [User]
| Counselor Mr Reynolds [User]

crewa

[new | [Edit] | copy | | Delete |

7. Click Close.

Delete a Filter

You can delete filters that you have added to your Filter menu. Deleting a filter deletes it from all
users who have access toit.

To delete afilter:

1. Click the Filter icon ? and then select Manage Filters:

The Manage Filters dialog box appears:
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Manage Filters

(Al Active Students [System]
Primary Active Students [System]
All Primary Students [System]
All Secondary Students [System]
Former Students [System]

Mext Year Students [System]
Begins with a [User]

All Students [System]

Active SPED Students [User]

E:
™

@ srow
() (1) (o) (o)

2. Click to highlight the name of the filter you want to delete.
3. Click Delete.
4. Click Close.

Using the Field Set Menu

Throughout Aspen, you can use field sets to customize the columns that appearin alist. When you
create field sets, you define the columns of information you want to see for every record on the

page.

Manage your field sets in the upper right comner of each page using the Field Seticon EE=)

Pages School Student ™ Staff Attendance Conduct Grades Assessment Schedule Global
Options Reports Help Y
Details </ [1: Abner, Andrew ~| 0 of 723 selected (7 Custom Selection
- [1|Last name First name: Middle name D LASID Grade
Contacts

[ |abner |Andrew |289-02.5017 254404 09
Attendance [ |abner Rose l482-92-3128 258027 1826380087 o9
Conduct [] |Agraham |Allisen Manica Bucso [472-04-4721 233888 1780807788 2011 10

From this area of the page, you can do the following:

« Create afield set.

« Modify an existing field set.
« Copy afield set.

« Delete afield set.
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Use Field Sets

Throughout Aspen, you can use field sets to customize the columns that appear in a list. When
you create field sets, you define the columns of information you want to see for every record on the

page.

Manage your field sets in the right-hand corner of each page using the Field Set menu icon EEE)

Pages School Student  Staff Attendance  Conduct Grades  Assessment  Schedule  Glebal Admin

Options Reports Help

Manage Field Sets..
Student List {

: < | . Emi [+ i
Details [[1: by, Emiy | 0 of 764 selected &7 All Active Students
- [ {name SASID LASID  |HIN1 |EnrStatus  (Grade |Homeroom HR Teacher
Contacts

[ |#bety, Emily 1247722110 238847 M |Active oz LGl
Attendance [1|adkerman, James 1345584589 292473 N |Active 11 D101 Hartwell, A
Conduct [ [#dam. Monique 1202489311 208844 [N lActive 11 E207 Deang, €

[ [sdams. Tyler 1852226004 287230 M |Active 12 D105 Baker, A
e [ |Aldorisio, Mingle 1172391282 232038 M |Active 10 D102 Baum, H 11/12/1882 maldarisio@eudors.com
Assessments  |IHIEEETE 1129252645 208872 [N lActive o2 E107 Siclie, £ 12/26/1992 ldsllen@scl.com

[ |#iper, Hesther 1082558420 248235 [N lActive 11 E101 Weisz, J 11/15/1992 halper@blusyonder.com
Schedule

[ [#mice. Elaine 1204051281 244040 [N |Active 12 B205 Ambrose, A /201881 lepilla@hotmail.com
Membership [ [Amico. Joseph 1215480388 205314 [N |Active 11 A101 Medwar, D 1/2/1883 lismico@eudora.com
Transactions [ [mics, Timethy 1082845502 241387 M |Active LE] E201 Brandy, H 114118985 ltamico@eudora.com

[ |#nderson, issbelis 1280205854 282480 [N lActive ] B105 Bowers, J s/12/12885 ipost@earthlink.com
Documents [ |#nderon, Le= 1208288082 280887 [N |Active 10 D104 Hollandg, K z/2e1884 Ivenkatesh@earthlink.com
Snapshots [ [Andersen. Margaret 1285487850 238301 M |Active 11 D201 Liu, K /201892 manderson@cemcast.com

[ [Andersen, Rose 1188357754 285284 M |Active 12 D201 Liu, K 5/3/1882 randersen@euders.com

[ |#nderson, Taylor 1028939048 221707 [N lActive 10 a204 Barr, D 1181284 com

< | [1: Abety. Emiy v|

From this area of the page, you can do the following:

« Create afield set.

« Modify an existing field set.
« Copy afield set.

« Delete afield set.

Create or Edit a Field Set

To create or edit a field set for a page:

1. Click the Field Seticon @ and then select Manage Field Sets:
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The Manage Field Sets dialog box appears:

Manage Field Sets

iDefault Fields [District]

snew

Close

2. Do one of the following:
3. Tocreate afield set, click New.
4. Tomodify afield set, select the field set to highlight it, and click Edit.

The Define Field Set dialog box appears:

Name Lodker List

Owner Administrator, System |

Avsilable Fields Sort A-Z Selected Fields

Student v Lodker

Identifier ~
Photo

Add = ¥

< < Remaove

=]
g |[c
2 ||l=
3

3. Type or edit the name for the field set.
4. Click the Owner drop-down to select who will be given access to the filter:

« User: to copy this field set for yourself or another user.
« School: to copy this field set for all users at your school.
« District: to copy this field set for all users in your district.
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5. Select the fields in the Available Fields list that you want to include in your field set, and click
Add.

6. Toremove afield from the Selected Fields list, highlight it and click Remove.

7. When the Selected Fields list contains all of the columns you want on your page in the order
you want them to appear, click Save. The Manage Field Sets dialog box displays the field set
you created or edited.

8. Click Close.

To test your new field set, select it from the Field Set list. The page displays the columns you
selected in the order you specified.

Copy a Field Set

After you create a field set, you can copy it:

« Make a copy for yourself to use as a starting point for a new field set.

« Assign a copy to another owner — either a user, school, or the entire district (if you have appro-
priate security privileges).

To copy a field set:

1. Click the Field Seticon @ and then select Manage Field Sets:

The Manage Field Sets dialog box appears:
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Manage Field Sets

iDefault Fields [District)

Down

Srow 1

Close

2. Select the field set you want to copy, and click Copy. The Save As dialog box appears:

Name | Copy of classroom teacher
Owner

Type | District |w*

Hame X2 School District

3. Inthe Name field, you can change the name of the field set.
4. Click the Owner Type drop-down to select one of the following:

« User: to copy this field set for yourself or another user.
« School: to copy this field set for all users at a school.

« Intermediate Organization: to copy this field set for all users in your intermediate organ-
ization.

« District: to copy this field set for all users in your district.

5. At the Owner Name field, click Q» to select a different user, school, or intermediate organ-
ization.

6. Click Save. The field set appears on the Manage Field Sets dialog box for the user you selected
at the User field.
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You can delete sort orders that you've added to your Field Set menu. Deleting a field set deletes it
from all users who have access to it.

To delete a field set:

1. Click the Field Seticon @ and then select Manage Field Sets:

The Manage Field Sets dialog box appears:

Manage Field Sets

iDefault Fields [District]

Show/Hide

Show All

() 1) (con] (o)

2. Click to highlight the name of the field set you want to delete.

3. Click Delete.
4. Click Close.

Sorting Data in Columns

On any list page in Aspen, you might be looking at hundreds or even thousands of records. The
datain each record is separated into columns, such as Name and Homeroom. For each column,
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it is possible to sort the data in either ascending (A-Z, 1-10) or descending (Z-A, 10-1).
There are two ways to sort the records that appear in columns in Aspen:

« Usethe Sort Order menu to create a custom sort order that you can save, name, and reuse at
any time.

« Use the Quick Sort option to create a temporary custom sort. The system will remember your
sort order for any list pages you visit during your current Aspen session only.

Use the Quick Sort Option

You can quickly sort the information in any column within Aspen —on list pages and in pick lists.
Click a column header to sort the records in ascending order. If you click the column header again,
the records sort in descending order. The system remembers up to three different sorts per list and
saves them as a custom sort during your current Aspen session. Note that the last column header
you click serves as the primary sort for your list.

To return to the default sort for the page, click the column header for the first column on the page.

To use the Quick Sort option:

1. Gotothe list page or pick list that you want to sort:

Pages Scenario  Workspace Courses Student Staff Rooms Rules Global

Options Reports Help

0 of 248 selected &7 Courses To Schedule

2
E
4
I

Crshio Description Sections. PPC Y AltGrp BindNext > Crsho
1010 English 9 H

8.0 11 022

English9C 6.0 11

015 English 9 Mod 0.0 0/

i g o
=

4
3

013 English 9 5 6.0 101
o
o

018 MCAS English 0.0 0/0

2. Click within the borders of the column header that you want to sort. Those records are sorted in
ascending order, and a triangle appears next to the header name 4. For example, click Depart-
ment to have records sort from Adminto Tech Ed.

3. Tochange that sort to descending order, click the column header again. The records sort from
Tech Ed to Admin, and the triangle in the column header is now inverted .

4. If youwant to add a second and/or third level of sorting, click another column header(s).
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Using the Sort Order Menu

Use the Sort Order menu to determine the order that records appear in on any list page. Manage

your sort orders in the upper-right corner of each page using the Sort Order icon .

In the following screenshot, the records are sorted by homeroom:

Conduct Grades Assessment Schedule Global

Pages School Student Staff  Attendance

Options Reports Help
Student List

Details “|[1410 v 0 of 760 selected &7

Contacts [] Name LASID |SASID 'Grade |Homeroom a DOB EnrStatus
[ |aldorisio, Mingle 233039 |1172991282 10 o 117121883 |Active

Aftendance [ |kisin, Kevin 224723 1048012338 os at104 12141984 |Adtive

Conduct [ |Meoannell. Zhihui 224815 |1200752263 09 104 5/11/1995 Active
[[]|gemsen. Haley 291785 |1085618137 LES 108 5/26/1995 Active hsarwar@topics.com
[ |swaim. Exsin 260216 |1038891831 o9 a104 3i21/1995 Active eswaim@hatmail.com
[ [Hiorth, Jense 214742 |1122807717 10 at08 6130/1994 Active ihjorth@topics com
[ |Legere, Ellen 279050  |1358773075 10 104 712611994 Active elegere@amail.com
[[] |#wetisyan. Daniel 212088 [1207122478 11 104 681293 Active davetisyan@comcast com
[[] |Burstein, Jensthan 287836 |1100588962 11 104 212511993 Active [burstein@eudera, com
[[] |Heffernan. Cassandra 282448 |1119323673 11 a104 41181993 Active corothers@hotmail.com

T [ |oMalley, Bridget 281380  |1025019028 11 at08 121411883 Active bo'malley@hotmsil.com
[ |seey, Sharyo 292450 |1111402428 11 104 11/2/1982 Active sellis@hotmail.com

SEE, [] | wilkins, Rysn 275845 |1325288728 12 a104 712611991 Active rwolIner@scl.com

The Sort Order menu contains a number of default options that are relevant to the page you're
looking at. In addition, you can create and save new sort orders.

Use the Sort Order menu to:

« Create or edit a sort order.
« Copy asort order.
« Delete a sort order.
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Create or Edit a Sort Order

Use the Sort Order menu to determine the order that records appear in on any list page. For
example, maybe you would like to see students ordered by street name. It is also possible to sort on
multiple criteria and to use a reverse sort order.

You can only edit a sort order you own. The edits you make apply to all users who have access to
the sort order.

To create or edit a sort order for a page:

1. Click the Sort Order icon , and then select Manage Sort Orders:

The Manage Sort Orders dialog box appears:
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iMame [System]

Grade lavel [System]
Homerocom [System)
Local |0 [District]
State |10 [District]

Show All

Close

2. Do one of the following:

o Tocreate asort order, click New.

» Tomodify a sort order, select the sort order to highlight it, and click Edit.

The Define Sort Order dialog box appears:

Basic Navigation

Name

Crwner

Local ID

Aspen Public Schools L

Available Fields

Student

[sertaz | Selected Fields

~ Local identifier

Identifier
Fheto

Last name
First name
Middle name

Title
Address
Suffix

Gender

State identifier
Date of birth

“fear of graduation
Grade level

- Name

= = Remove

Save | | Cancel

3. Atthe Name field, type or edit the name for the sort order.

4. Click the Owner drop-down to select who will have access to the sort order:
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« If you do not have access to set school or district ownership levels, this box does not appear.

« |If you have appropriate access, you can select your district as the Owner. If you do this, all
users in the district will see this sort order in their list.

« If you have appropriate access and are in the Intermediate Organization view, you can select
your intermediate organization as the Owner. If you do this, all users in the organization will
see this sort order in their list.

« If you have appropriate access and are in the School view, you can select your school as the
Owner. If you do this, all users in the school will see this sort order in their list.

« If you are creating this sort order for yourself only, select your name.

5. Select the fields in the Available Fields list that you want to include in your sort order.

6. Click Add.
7. Doany orall of the following:
« To remove a field: Select it to highlight its name in the Selected Fields list, then click
Remove.

« To change the order of the sort: Select it to highlight its name in the Selected Fields list,
and then click Up or Down.

« To reverse a sort order: Highlight a field in the Selected Fields list, and click Change sort.

For example, if your selected field is Physical Address > Street name and you click Change
sort, the records on your list page will appear alphabetically from Z to A instead of A to Z.

8. When the Selected Fields list contains all of the fields you want to sort by in the appropriate
order, click Save. The Manage Sort Orders dialog box displays the sort order you created or
edited.

9. Click Close.

10. Totest your new sort order, select it from the Sort Order menu . The page displays the
records in the order you specified.
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Copy a Sort Order
After you create a sort order, you can copy it:
« Make a copy for yourself to use as a starting point for a new sort order.
« Assign a copy to another owner — either a user, school, or the entire district (if you have appro-

priate security privileges).

To copy a sort order:

1. Click the Sort Order icon , and then select Manage Sort Orders:

Manage Sort Orders. ..

The Manage Sort Orders dialog box appears:

Manage Sort Orders

iMame [System]
Grade lavel [System]
Hormeroom [System]
Local 1D [District]
State |10 [District]

srow A

Close

2. Select the sort order you want to copy, and click Copy. The Save As dialog box appears:

HName | Copy of Homeroom
Owner

Type | User W

Hame Administrator, System q

-91-



Basic Navigation

3. Inthe Name field, you can change the name of the sort order.

4. Click the Owner Type drop-down to select one of the following:
« User: to copy this sort order for yourself or another user.
« School: to copy this sort order for all users at a school.
« Intermediate Organization: to copy this field set for all users in your intermediate organ-

ization.

« District: to copy this field set for all users in your district.

5. Atthe Owner Name field, click q to select a different user, school, or intermediate organ-
ization.

6. Click Save. The sort order appears on the Manage Sort Orders dialog box for the user you selec-
ted at the Type field.

7. Click Close.

Delete a Sort Order

You can delete sort orders that you have added to your Sort Order menu. Deleting a sort order
deletes it from all users who have access to it.

To delete a sort order:

1.

Click the Sort Order icon 222 and then select Manage Sort Orders:

Y = &=

The Manage Sort Orders dialog box appears:
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Manage Sort Orders

iMame [System]
Grade lavel [System]
Homerocom [System)
Local ID [District)
State |0 [District)

O] srow

2. Click to highlight the name of the sort order you want to delete.
3. Click Delete.

4. Click Close.
Use the Quick Print Menu

Use the Quick Print menu on list pages to quickly create reports to capture information about the
list of records you are viewing in a printable format:

ELES District  School Student Staff Grades |[PASSBSSmMEnt Schedule Global Tools  Admin
Options Reports Help

Document Structures

Assessment e - 0 of 26 selected &7
Definition

Description

All Rey
Assessment

History

Rubric Library

Using the Quick Print menu, you can create two types of reports:

« A Quick Print, which is a Simple Quick Report that instantly prints the list of records you are
viewing in a formatted report.

To generate a Simple Quick Report (known as a Quick Print), click the Printer icon. Select
an output format, such as Web Page (HTML), and your Quick Print appears:
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Student List - All Active Students
Name SASID LASID H1N1 | EnrStatus | Grade | Homeroom | HR Teacher | DOB Email 1
Ackerman, James | 1345564569 | 293479 N Active " c107 Wilson, A 8191992 |jackerman@comcast com
Adam, Monique 1302499311 | 206544 N Active " E207 Deang, C 1/2011993 | madam@blueyonder.com
Adams, Tyler 1652226004 | 297230 N Active 12 D105 Baker, A 7101991 |fadams@gmail.com
Aldorisio, Mingle 1172991282 | 232039 N Active 10 D103 Baum, H 11/13/1993 | maldorisio@eudora.com
Allen, Diana 1129254645 | 208672 N Active 09 E107 Sjolie, E 12/26/1993 | dallen@aol.com
Alper, Heather 1062556430 | 248235 N Active il E101 Weisz, J 11/15/1993 | halper@blueyonder.com
Amico, Elaine 1304051361 | 244040 N Active 12 B205 Ambrose, A | 6/20/1991 | epilla@hotmail com
Amico, Joseph 1215480988 | 205314 N Active 11 A101 Medwar, D | 1/2/1993 jamico@eudora com
Amico, Timothy 1062645502 | 241387 N Active 09 E201 Brandy, H 1/14/1995 | tamico@eudora.com
Anderson, Isabella | 1260305854 | 283490 N Active 09 B105 Bowers, J | 5121995 |ipost@earthlink.com
Anderson, Lee 1208266062 | 260687 N Active 10 D104 Holland, K | 2/24/1994 | lvenkatesh@earthlink.com
Anderson, Margaret | 1395487850 | 236301 N Active " D201 Liu, K 6/20/1992 | mandersonf@comcast.com
Anderson, Rose 1188397751 | 255264 N Active 12 D201 Liu, K 5/3/1992 randerson@eudora.com
Anderson, Taylor 1038930046 | 231707 N Active 10 A204 Barr, D 1/18/1994 | thoulgate@aol.com
Anderson, Zachary | 1360247593 | 213726 N Active 10 E102 Wilson, A 11/28/1993 | zimsong@webfoof com
Antuna, Erika 1330258775 | 272189 N Active 11 M101 Gordon, J 11/24/1992 | ejolicoeur@earthlink.com
Arakelian, Andrew | 1090613445 | 254713 N Active 10 B205 Ambrose, A | 11/17/1993 | agannaway@webfoot com
Arakelian, James 1048595505 | 210338 N Active 09 E207 Deang, C 5/201995 | jarakelian@msn com

« A Quick Report, which is an on-the-fly report of the information you are viewing on a list page.
You decide what's on it, and the system formats it to look professional.

There are four types of Quick Reports:

« Simple: Produces a list of the records and fields you select to include

« Detail: Produces a page for each record, and the report aligns the data fields vertically instead of
horizontally

« Group: Groups records by the fields you select, such as homeroom
« Summary: Hides individual records from the list and produces a list of cumulative values based
on the records

To create a Quick Report, click the Printer icon, and click Create Quick Report. The Quick
Report wizard appears and walks you through the steps of creating the report you need.

Use the Dictionary Menu

Use the Dictionary menu to access a list of available extended Data Dictionaries. Then select the
one you want. Doing so enables you to work with the columns defined in that dictionary.

For example, if the High School Transcript Definition contains the columns Term 1 Grade and Term
2 Grade, you will be able to use these columns in field sets, queries, and sort orders after selecting
High School Transcript Definition from the Dictionary menu.

Note: This menu only appears in Aspen on lists that use extended Data Dictionaries, like
transcripts and IEPs.

Manage your extended Data Dictionaries in the upper-right corner of the page by clicking the
Dictionary icon [I-—-I:
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Pages

Options

Details

Contacts

Attendance

Conduct
Transcript
Details

Credit
Summary

Grade Point
Summary

School
Reports

Student
Help

Student List :: 10 - Ditomassi, Alexander Q

Staff

Attendance

Conduct

Grades

Assessment

Schedule Global

0 of 9 selected &7

HS Transcipt Definition

D fear Grade Course Desc Finalavg

[]|=200e 10 Homercom

[]|200e 10 English Il 0.0
[ [z008 10 Modem World History 0.0
[ [z00e 10 Rlgabes 1| 0.0
[]|z009 10 Chemistry 0.0
[]|2002 10 AF Physics 8 0.0
[ [z008 10 Spanish IV Advanoed 0.0
[]|=200e 10 Advanced Music Theory 0.0
[]|z009 10 Fitness Concepts 1| 0.0

Use the Maximize Icon

The Maximize icon = lets you view more of the page body in Aspen:

RETH
Options

Staff List

Details
Attendance
Schools
Documents

Forms

Snapshots

District

Reports

:: Abety, June

Attendance

Conduct

Grades

Assessment

Schedule  Global

Tools  Admin

< «[Q]»]r]

Cancsl

| Default Template

ol

Demographics |

First name *

Middle name

June

&
4
i
a

School = Name

Local identifier

QX

‘Sﬂuth Elementary School
Lastname = [mbety State identifier
st -—
— —
- o T -
o i - N
Work Phene Hire date &=
con e -

Primary email
Homeroom

Homercom 2

‘]ahety@hntma\\ com

il

Bargaining unit

District Attendance
Group

EPIMS Status

BPS Employsas”

5]
i
a
@
<
7 | £

Click the Maximize icon
more of the main part of the page:

&
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Options Reports Help ]
Staff List :: Abety, June < «[Qf»]r]
[etauit Template >

Demographics | | |

First name * School > Name Q, X

Widdle name Local identifier 11633

H

Lastnamety State identifier

e Status

Gender Department Occupstional Therapy (v

Date of birth 4711984 B o= 46 Type

<

& RIBIBIG
diiaE

) o

3

3

< &
< g

g

Home Phone Special Ed

Werk Phone Hire date

3
i

@
H

Cell Phone

2
1]
<

Bargaining unit

HIBIE I
IR
RS I
mgm

IEIE

District
Group

Primary email sbaty@hotmail.com

il
o

m
II

Homergom EFIMS Status

Il

Homercom 2

e

This feature is especially useful on long pages, such as the Student detail page. In Maximize

mode, the Maximize icon is replaced by the Minimize icon. Click the Minimize icon ] to show
the full page again.

Use Quick Charts

Quick Chart is a part of Data Analytics in Aspen. Charts provide an organized way to visually
represent data.

The Quick Chart feature enables you to create bar, line, and pie charts from any standard list page.
These charts can be saved for future use.

Users with privileges to manage school and/or district resources can create charts to share school-
and district-wide. The charts are generated through the generic reporting structure of Aspen and are
therefore fully customizable.

There are three chart types:

« Bar
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B Seriesl
® Series2
« Line
5
4
3 -
2 ==Seriesl
1 -Series 2
£
0* 01} 0*
+« Pie

Select one of the following topics to learn more about Quick Charts:

« Create a Quick Chart
« Use Quick Print Charts
o Quick Chart Examples
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Create a Quick Chart

On all standard list pages, click the Quick Charticon ID to access the following options:

« Create Quick Chart: Brings up the Quick Chart Wizard, which allows you to customize many
different areas of the resulting chart.

« Bar Chart: Brings up a streamlined Quick Chart screen, which requests only minimal inform-
ation required to create the bar chart.

« Line Chart: Brings up a streamlined Quick Chart screen, which requests only minimal inform-
ation required to create the line chart.

Pie Chart: Brings up a streamlined Quick Chart screen, which requests only minimal information
required to create the pie chart.

To create a Quick Chart:

In any standard list view, click -ﬂ:’ and select Create Quick Chart to open the Quick Chart
wizard, or select Quick Chart from the Reports menu.

The Create Quick Chart wizard appears:

Quick Chart: Source Step 1 of 5

e

Source

@ Mew report
B Series1 - i

B Serias? Saved report

(SRR R TT

N T
e@?ddfﬁgﬁé‘

& F o

=Series 1

= Series 2

e oW i
’
] ;%(

£ £ (‘\m
c;"@@ L;"J? c;*d-?
W Category 1
B Category 2
Category 3

The Create Quick Chart wizard has five steps:

Step 1: Source
1. Click one of the following:

« New report: Select this option if you want to create a Quick Chart from scratch.
« New report: Select this option if you want to create a Quick Chart from scratch.
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N

If you select Saved report, a table of saved Quick Charts appears in the dialog box. Select the
Quick Chart you want to view or edit.

If you selected New report, click Next. If you selected Saved report you can click Next to con-
tinue editing, or Finish to show the chart.

w

Step 2: Report Type

Quick Chart: Report Type Step 2 of 5

wn

W

Report Type | Quick Chart-Line «

= | N This is a line chart. Pick one or two group by fields to display. The information is
By | g | CErEss displayed as a8 series of dsta points connected by line segments. Each dsts point
the of each categ i axis) for each series (legend

entries).

ot G Format Standard Line Chart

5

44

2l =Series1
1

0

=Series 2

E=

1. Click the Report Type drop-down to select one of the following:
« Quick Chart—Bar
« Quick Chart—Line
« Quick Chart—Pie

2. Click the Format drop-down to select the format for the chart. A Standard version and an
Enhanced (3-D) version are provided with Aspen.

3. If this is a new report, click Next. If you are editing a saved report, you can click Next to con-
tinue editing, or Finish to show the chart.
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Step 3: Field Selection

Quick Chart: Field Selection Step 3 of 5

Cateqgories [{Horizontal Axis}

Group by field “fear of graduation Q
Interval Total summaticn -
Group trivial results as "Other" v Less than & %

o

4 Series (Legend Entries}

3 P . Group by field Q

2 =Seriesl

14 =Series? Group trivial results as "Other"

P " CAY

£ d'?d d'?d
& &

1. Inthe Categories (Horizontal Axis) box, click Q at Group by field and make a selection.
You can choose from the tables and fields that are related to the records in your current list. The
Categories (Horizontal Axis) box, sometimes called the independent variable, sets the data
you want to measure. If you choose a Numeric, Date or Time field, additional options appear to
further organize the data which will be displayed on the chart. The following table describes each
of the possible selections which require additional fields:
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Description

(example)

Interval

Numeric (YOG) Interval group size

Group insignificant
data

Less than n%

Date (Date of

Birth) Interval

The Interval drop-down menu for
numeric has the following options:

« Chart each value separately: Each
numeric value gets its own data
point.

« Interval group: The Interval field
groups the results according to the
number entered in the Interval
group size field. For example, if you
want the group Year of Graduation
to display in the chart in pairs, you
would enter 2 in this field.

« Interval group summations

« Total summation: Sums the values
of the Group by field.

The Interval group size appears if
you select Interval group or Interval
group summations at the Interval
field. The value in this field sets the
number of data points that get
combined into a single category.

Select this checkbox if you want to
group all data points of less than a
certain percent. For example, if you are
only concerned with viewing the
several most common conduct codes,
you might want to select this option
and enter a value of 5% or 10% in the
Less than n % field.

Note: You are only able to use this
option in the Categories or Series,
but not both.

Sets the percent under which data is
grouped in the Other category.

The Interval drop-down for a date type
field has the following options:

o Chart each date separately
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Selection Type

Additional Fields Description

(example)

By day of week

By day of week and month
By day of week and year
By week

By week and year

By month

By month and year

By school year

The Interval drop-down for a time type
field has the following options:

Time (Time) Interval A

Chart each time separately
By minute

By minute, hour and date
By hour

By hour and day

For bar and line charts, a Series (Legend Entries) box is available. Click Q at the Group by

field and make a selection. Additional options are available, as described above for Categories
selection. Series groups appear in a legend to the right of the chart and provide a color-coded

guide to data shown in the chart.

Note: Bar and line charts do not require both a category and series to be selected. Charts
that exclude a category will not have x-axis labels. Charts that exclude a series will not

include a legend.

3. If thelist of data being charted contains trivial cases which should be excluded from the chart,
the option Group trivial results as "Other" is provided. Select this checkbox if you want to
group all data points of less than a certain percent together into a single point called Other. For
example, if you are only concerned with viewing the most common conduct codes, you might
want to select this option and enter a value of 5% in the Less than n % field. This will group all
codes which total less than 5% of the total data into a single Other group.

Note: You are only able to use this option in the Categories or Series, not both.

4. You can click Next to continue the wizard and set chart options, or Finish to create the chart.
New charts use the default format options if you click Finish at any point before the final step in

the wizard.
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Quick Chart: Format Options Step 4 of 5

- Header

El

H Report title Student List by Year of graduation - Active Stud

- Print date

Footer Data Set Totals Page Break

i Chart summary I:‘
5
4
3
2] =Series 1
I =%eries2
oA

™ * it
£ £ £4

u"@t? U*J? u*oc?
e

Basic Navigation

1. Inthe Report title field, enter a title for your report. The title appears above the chart.
If you want the date the report was created to appear on the report, select Print date.
3. If you want a table of data summarizing the chart to appear below the chart, select Data Set

Totals.

4. If youwant the table data summarizing the chart to appear on its own page, select Page Break.
5. Click Next to continue editing, or Finish to show the chart.

Step 5: Save Options

Quick Chart: Save Options Step 5 of 5
i Save Options
5 Don't save
3 Save
_ @ Saveas
il ARl ey
e
e Name “fear of Graduation
% Owner
31
i Type User -
2] =Series1
=1 i, X2
I+ zerias2 Hame upRo Q
L A
D#J? E/#J? D#J?
oo )l -
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3.

4.
5.

In the Save Options section, click one of the following:
« Don’t save: The report appears in your job queue, but if you want to run the chart again, you
must recreate it.

« Save: This option is only available if the chart has already been saved. This option overwrites
the previous version.

« Save as: This option saves the chart with the name you type in the Name field.

If you selected Save as in the Save Options section, type what you want to name the chart in
the Name field.

Under Owner, select District or User from the Type drop-down.

If you select the type User in the Type drop-down, click Q at the Name field to select a user.
Click Finish.

The chart appears in a pop-up window.

Quick Chart Examples

Following are real-world examples of how you can use Quick Charts:

Example 1: Pie Chart

Example 2: Line Chart

Example 3: Bar Chart

Example 4: Using Quick Charts with Analytics

Quick Chart Example: Pie Chart

The affirmative action committee for the Aspen school district is studying the diversity of the
student population. Members want to create a pie chart showing the percentage of students by

race. Cindy Kelley, a guidance counselor at Bay Middle School, and an Aspen system administrator
for the district volunteer to create the pie chart.

To create the pie chart:

1.

Cindy logs on to the District view and clicks the Student tab.

2. She then clicks ID and selects Create Quick Chart to bring up the Quick Chart Wizard.

In Step 1 of the Quick Chart wizard, Cindy selects New report and clicks Next.

In Step 2 of the wizard, Cindy selects Quick Chart - Pie for Report Type and Standard Pie
Chart for Format and clicks Next.

In Step 3, Cindy selects the field to be used for the pie chart. She clicks Q in the Categories
(Horizontal Axis) section to the right of the Group by field to open a pick list. She can choose
any of the available fields from the current list. Because she is specifying a chart where each
slice of the pie represents the number of students in each of the possible values for the Race
field, she selects Student for the Table, and Race for the Group by field. She then clicks OK to
save her selections. She clicks Next.
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Group by field

Available Fields Sort A-F

Student -
I - |
Address

Local identifier
State identifier
“fear of graduation
Date of birth
Grade level
Homeroom
Enrocliment status
Calendar

Race

Alerts

Cuidk Status

In Step 4, Cindy enters Aspen School District Students By Race for the Report title. She uses
the default settings for the remaining chart format options and clicks Next.

In Step 5, Cindy selects Save as and enters Students By Race in the Name field and clicks
Finish.

The resulting pie chart appears:
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AfricanAmerican
(8.42%)

AfricanAmerican,
Caucasian (2.27%)

[Caucasian (82.72%) |

Quick Chart Example: Line Chart

Crow Point High School principal Michael Rogers wants a line chart for a visual representation of
the GPA of seniors.

To create the line chart:

1. Michael logs on to the School view and clicks the Grades tab.
2. He queries for YOG=2012 AND Year ID = 2011-2012 (latest cumulative GPA).

3. Hethenclicks ih and selects Create Quick Chart to bring up the Quick Chart wizard.
In Step 1 of the Quick Chart wizard, Michael selects New report and clicks Next.

5. In Step 2 of the wizard, Michael selects Quick Chart - Line for Report Type and Standard Line
Chart for Format and clicks Next.

6. In Step 3, Michael specifies the data he wants displayed in his chart. He clicks Q in the Cat-
egories (Horizontal Axis) section to the right of the Group by field to open a pick list dialog
box, and chooses Student Grade Point for the Table, and Cumulative grade point average for
the Group by field. He then clicks OK to save his selections and return to the Field Selection
step of the wizard. Because Cumulative grade point average is a numeric field, he must spe-
cify the Interval for the categories on the horizontal axis. Michael selects Interval group for the
Interval and specifies 0.5 for the Interval group size. The categories on the horizontal axis will
be cumulative GPAs of 0.0-0.5, 0.5-1.0, 1.0-1.5 and so on. The first category contains cumu-

lative GPAs from 0.0 up to but not including 0.5. Michael clicks Q in the Series (Legend
Entries) section to the right of the Group by field and chooses School Year Context for the
table and Year ID for the field. He then clicks OK to save his selections. He clicks Next.
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In Step 4, Michael enters Cumulative GPA of HS Seniors in the Report title field. Michael uses
the default settings for the remaining Header options. For the Chart summary, Michael
accepts the default for Data Set Totals (selected by default) and clicks Next.

In Step 5 of the Quick Chart Wizard, Michael uses the default values and clicks Finish.

The resulting line chart appears.

Quick Chart Example: Bar Chart

Zachary Lareau, one of the assistant principals of Crow Point High School, implemented an
attendance incentive program in the 2010-2011 school year.He would like to compare the
attendance of 2010-2011 with the two previous school years using a bar chart.

To create the bar chart:

-_—

9.

Zachary logs on to the School view and clicks the Attendance tab.
He clicks the Daily History side-tab.

He filters his data on all records starting from the first day of the 2008-2009 school year through
the last day of the 2010-2011 school year.

He then clicks ID and selects Create Quick Chart to bring up the Quick Chart wizard.
In Step 1 of the Quick Chart wizard, Zachary selects New report and clicks Next.

In Step 2 of the wizard, Zachary selects Quick Chart —Bar for the Report Type and Standard
Line Chart for Format and clicks Next.

In Step 3, Zachary specifies the data he wants displayed in his chart. He clicks Q' in the Cat-
egories (Horizontal Axis) section to the right of the Group by field to open a pick list, and
chooses Student Attendance for the Table and Date for the Group by field. He clicks OK to
save his selections. Because Date is a date-type field, he must specify the Interval for the cat-
egories on the horizontal axis. Zachary selects By school year for the Interval. The categories
on the horizontal axis will be each school year in the Date field of the current list. For the Series

(Legend Entries), Zachary clicks Qa in the Series (Legend Entries) section to the right of
the Group by field to open a pick list. Zachary specifies Student Attendance for the Table and
Code for the Group by field. The series will consist of each code value in the Code field. He
clicks OK to save his selections and return to the Field Selection step of the wizard. Because
Code is a character-type field, Interval is not displayed. Zachary selects the Group insig-
nificant data checkbox and enters 10 in the Less than % field so that codes with less than
10% of the total population are grouped in an Other series. He clicks Next.

In Step 4, Zachary enters High School Yearly Attendance Trends in the Report title field.
Zachary uses the default settings for the remaining format options and clicks Next.

In Step 5 of the Quick Chart wizard, Zachary uses the default values and clicks Finish.

The resulting bar chart appears.

Using Quick Charts with Analytics: an Example

Cindy Kelly, the guidance counselor at Bay Middle School and an Aspen system administrator, is
comparing the number of student absences for this year for all schools in the district. The
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Attendance by Student analytic is run each evening. She wants to create a bar graph of the absent
totals by school.

To use Quick Charts with Data Analytics:

1. Cindy logs into the District view, and selects the Global tab, Analytics side-tab.
2. From the Dictionary menu, she selects Attendance by Student.

3. Shethen clicks l_D and selects Bar Chart to bring up the Quick Chart pop-up for bar charts.

4. Sheclicks Q in the Categories (Horizontal Axis) section to the right of the Group by field to
open a pick list, and chooses School for the Table and Name for the Group by field. She clicks

OK to save her selections. For the Series (Legend Entries), she clicks Q inthe Series
(Legend Entries) section to the right of the Group by field to open a pick list. She specifies
Attendance by Student for the Table and Absent Total for the Group by field. She clicks OK to
save her selections. She selects Total summation for the Interval. This will provide the sum of
the values in the Absent Total column for each school in the district.

5. She accepts the default for the Format and clicks OK.

The resulting bar chart appears.

Using Snapshots to Create and Store Groups

A snapshot represents a static filter. Think of a snapshot as a picture of a particular group of
students, staff members, courses, or rooms that you can file and easily retrieve.

For example, assume you manage the Math club and want to be able to quickly access all of the
students who are members. You can use a query to find the students initially, and then create a
snapshot of these students. This way, each time you want to work with students in the Math club,
you need only refer to your snapshot.

To create a snapshot:

1. Do one of the following:

2. Search for or select the records you want to include in your snapshot. You might select these
records individually, or use a query to find them.

Note: Be sure to select the checkbox next to each record you want to include in your
snapshot, click the Options menu, then click Show Selected.

3. Onthe Options menu, click Snapshots.
4. Inthe Manage Snapshots dialog box, click New. The Snapshot Definition dialog box appears:
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Name Math Club
Crhavner Aspen Public Schools |[w
Sawve as filter

Mowe to top of my list |:|

Records to Include

{(®) Cument List

() Snapshot Combination

Save Cancel

5. Type a name for this snapshot.

6. Click the Owner drop-down to select the user, school,intermediate organnization, or district as
the owner. This determines which other users, if any, can use this snapshot.

Note: Not all users have privileges for all levels of ownership.

7. If you would like to make this snapshot an option on your Filter menu f, select the Save as
filter checkbox.

8. If you would like this snapshot to be your default filter (for example, whenever you open the Stu-
dent List, these are the records you'd like to see), select the Move to top of my list checkbox.

9. Inthe Records to Include box, select one of the following:

« Current List to include only those records you selected checkboxes for on the list page.

» Snapshot Combination to combine two existing snapshots. (This option is only available if
you have already defined at least two snapshots.)

10. If you selected Snapshot Combination, use the following table to determine how you want to
assemble the two snapshots you select:

-109 -



Basic Navigation

Select To include the following in the snapshot:

Any records that appear in the first snapshot you select or the second
shapshot you select. For example, if you want to create a snapshot of
students who appear on either or both the first term and second term
honor roll, select Union.

Union

Only records that appear in both the first and second snapshot you
Intersect select. For example, if you want to create a snapshot of students who
appear on both the first and second term honor rolls, select Intersect.

Any record that appears in the first snapshot you select, but not in the
second. For example, if you want to create a snapshot of students who
appear on the first term honor roll, but not on the second term honor roll,
select Difference.

Difference

11. Click Save. The Manage Snapshots dialog box displays the snapshot you created.

12. Select the snapshot you created, and click Use. The list page displays the records in the snap-
shot selected.

Note: You can also save a snapshot to the Filter menu on a list page. Then, you can
quickly select that snapshot.

Manage Snapshots for Individual Records

You can manage the snapshots a specific student, staff member, room, or course is a member of.
For example, assume you create a snapshot of all students on the Volleyball team at the beginning
of the season. Then, a student joins the team. Select that student and add him or her to the
snapshot.

To manage snapshot membership for an individual record:

« Tomanage student snapshots, click the Student tab.
« Tomanage staff snapshots, click the Staff tab.

2. Search for and select the specific record.

3. Click the Snapshots side-tab. A list of snapshots the student, staff member, course, or room
belongs to appears.

4. Do one of the following:
« Toadd the record to a snapshot, on the Options menu, click Add. The Snapshot Pick List
appears. Select the snapshot and click OK.

« Todelete arecord from a snapshot, select the checkbox next to the record. On the Options
menu, click Delete.
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Use Breadcrumbs

Aspen leaves breadcrumbs at the top of each page to remind you of the path you took to access
the page you are currently using:

The breadcrumbs contain each page you accessed to arrive at the current page. For example, the
user in the screenshot above clicked the Schedule tab, selected the World Mythology course,
selected Teachers on the Master side-tab, then clicked Jenette Porter.

Any breadcrumb in blue is a link to that page. For example, if you click , the school's master
schedule will appear.

Use breadcrumbs to quickly return to the most recent pages and information you used.

Use Pick Lists

Throughout Aspen, a magnifying glass q appears next to many of the fields. This means that
there is a pick list associated with a particular field. For data consistency purposes, you must

enter values in these fields from a list of predetermined codes. When you see Qa , you can do
either of the following:

« Begin to type the value you want to enter in the field. The system attempts to find a match. For
example, assume the school nurse begins to type Head... in the Primary Complaint field for a
health visit. The system completes the entry: Headache.

o Click Q . A pick list appears:
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ROOT  List View == Categories Cnly
=S By bt B 60 records £/
|Code |Description | State
@.Esrame .EErEd'IE .
{:-EFsint :Fsirlt
{:- :Fsti;us :Fstig ue
(3] :Fir_=,t aid 53 “Fi.'s-‘t aid
] :HEEI«.".. Injumy :HEEIEi Injury
D:Hesdsd".e J :Hssda:hs
{::l iHeat Exhausticn “H'_=5|t Exhausticn
'.':'EHi':’:i-F :HiCﬂ.:_E
O ;Hy-gisns :Hygiens
{:- ;Ir:fluer!zs “Influr:nzs
Cancel

If the reference table associated with the field consists of categories of codes, the top of the pick
list displays two options:

« Click List View to display a list of all possible values you can enter in the field.

« Click Categories Only to display a list of categories. Categories contain groups of related val-
ues.

When school years are on the pick list, they are listed in descending order with the most recent year
on top.

To select a value, do one of the following:
« Click the button next to a value, such as Head Injury, to insert it into the field, and click OK.

« Click the folder ' next to a value to view the available values within that category. For

example, if you click (| next to Headache, a list of types of headaches appear:

ROOT = Hesdache

60 records /7
|Code |Description State
@} :E}‘E Strain Headache :E}‘E Strain Headache . ]
-Q;Einus Headache ;Einus Headache
{:‘.l .Etresrs- Headache .Etresrs- Headache

« Click the button next to a value to select it, and click OK.
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Using Queries to Find a Group of Records

A query represents a dynamic filter. It helps you search for and filter a group of records that
matches specific criteria at a particular time.

For example, you can perform a general search for a group of students with the same year of
graduation, or a more specific search for students in the same graduating class in a particular
homeroom.

You can also save queries you use often. Or, you can copy queries to use as a shell to create a
new query for yourself, or share queries with other users, your school, or your district.

There are three modes of queries:

« Simple Mode: These queries search for records based on the system’s lists of tables, fields,
and operators.

For example, create a Simple query to search for all students graduating in 2012 who are in
homeroom 100. After you save this query and run it again, it will always return a list of
students graduating in 2012 who are in homeroom 100. Saved Simple queries always search
for records based on the same criteria.

« Advanced Mode: These queries also search for records based on the system’s lists of tables,
fields, and operators, but have added functionality. When you use a saved Advanced query,
you have the option of changing the search criteria before it completes the search.

For example, create an Advanced query to search for all students graduating in 2012 who are
in homeroom 100. After you save this query and run it again, you can change some or all of
the search criteria. You can search for students graduating in 2012 who are in homeroom
150. Saved Advanced queries can be changed to search for records based on different
criteria than the criteria they were originally created for.

« Direct SQL Mode: These powerful queries search for records based on your own self-defined
criteria, not the system’s tables, fields, and operators. You use SQL syntax to define the cri-
teria; therefore, you are not limited by interface restrictions.

For example, create a Direct SQL query to search for all students who have more than one
absence this year.

In Simple and Advanced modes, you can also create parenthesized queries to manage and group
complex search conditions. Parentheses allow you to group criteria, resulting in a more powerful
search tool.

With a parenthesized query, a single search produces results that would require multiple queries
using the basic method. For example, you can search for records that meet the following
conditions:

« all females who are in homeroom 287; or

« all females who are in homeroom 360; and
« Wwhose graduation year is 2010; or

« whose graduation year is 2011.

-113-



Basic Navigation

Create Simple Mode Queries
Simple mode queries search for records based on the system’s lists of tables, fields, and operators.

For example, create a Simple query to search for all students graduating in 2012 who are in
homeroom 100. After you save this query and run it again, it will always return alist of students
graduating in 2012 who are in homeroom 100. Saved Simple queries always search for records

based on the same criteria.

To create a Simple query:

1. Gotoalist page, such as the Student List.
2. Onthe Options menu, click Query. The New Query dialog box appears:

New Query { | simple Mode v )l

Tables Student W
”
Grade level
Homerocom
i Sort A-Z A
TR Home Phone Ane
Enrcliment status
Lodker b
b

Cperator Equals

Value 2012

Search criteria

“ear of graduation Equals 2012

Search based on | All Active Students W

[ Search ][ Cancel ] [NE‘-.'.'][ Save As.. ][ Select...

3. Use the following table to complete the fields:
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Field Description

Select the table you want to search information in. The table

you select determines the Fields selections.
Tables
For example, if you select the Student table, fields such as

Year of graduation and Last name appear.

At Fields, select the field you want to include in the search
criteria.

Fields

Select an operator.

For example, if you are searching for students with a specific
year of graduation, select Year of graduation in the Fields
box, and select the Equals operator.

Operator

Enter the value you are searching for.
Value
For example, 2010.

In the Tables field, select the table you want to search information in. The table you select
determines the Fields selections. For example, if you select the Student table, fields such as
Year of graduation and Last name appear.

. AtFields, select the field you want to include in the search criteria.

Click Add to add the criteria to the Search criteria box.

. To delete the criteria from this search, highlight it and click Delete. Or you can add other cri-
teria, or click Search to search for students who match the one criterion you defined.

. Toadd other criteria, select the Table, Field, and Operator, and enter the Value, if appropriate.
Then, click And or Or to determine if the students should meet the first criteria, the second cri-
teria, or both to be included in the search:
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New Quer'f . Sirn.ple I'u'lu::de. v.

Tables Student W

Home phone
Enrollment status

Fislls Losker And
Phane 2
|[Phone 3 !
Operator Equals W |

Walue 101

Search criteria

And Homeroom Equals 101

Search based on | Active Students W

[New] [ Sawe As... ] [ Select... ]

9. At Search based on, select the records you want to search on to determine which records are
included in this query.

10. If you want to save this query to use it again or to give other users access to it, click Save As.
The Save As dialog box appears:
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Name

Query

Owner type User v
Owner name Administrator, Joe Q
Filter

Save as filter |:|

Owner type
Owner name Adm 'E'.':-'.:'.:eQ

Move to top of my list

Save [| Cancel

11. Use the following table to complete the fields:
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Field Description

Name Type a name for the query.
Click the drop-down to select one of the following:

« User: to give a user or yourself access to the query
Query Owner type « School: to give users at a school access to the query

« Intermediate Organization: to give all users in an inter-
mediate organization access to the query

« District: to give all users in the district access to the query

Query Owner name Click Qa to change the owner of the query. The owner can
edit a saved query.

Select this checkbox to have this query automatically appear

on the Filter menu ' on this page for all users who are given
access toit. If this is selected, the next three fields are
accessible.

Save as filter

Click this drop-down to select one of the following:

« User: to give a user or yourself access to the filter
Filter Owner type « School: to give users at a school access to the filter

« Intermediate Organization: to give all users in an inter-
mediate organization access to the filter

« District: to give all users in the district access to the filter

Filter Owner name Click q to change the owner of the filter. The owner can edit
a saved filter.

Select this checkbox to have this filter appear first on your
Filter menu 1.

Notes:

Move to top of my list
« Including queries on your Filter menu allows you to
quickly select a group of records when you access a
list page.
« If aquery is first on your Filter menu, it becomes
your default filter.

12. Click Save.
13. Click Search. The list page displays the records that meet your search criteria.
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Create Advanced Mode Queries

Advanced mode queries search for records based on the system’s lists of tables, fields, and
operators, but have more functionality than Simple queries. When you use a saved Advanced
query, you have the option of changing the search criteria before it completes the search. And you

can save an Advanced query as a filter so it appears on your Filter menu 1. Youthen can easily
run it from there, and you'll be prompted to enter the values. This allows you to create the query
once, but use it for multiple purposes.

For example, create an Advanced query to search for all students graduating in 2012 who are in
homeroom 100. After you save this query and run it again, you can change some or all of the
search criteria. You can search for students graduating in 2012 who are in homeroom 150. Saved
Advanced queries can be changed to search for records based on different criteria than the criteria
they were originally created for.

To create an Advanced query:

. Gotoalist page, such as the Student List.
2. On the Options menu, click Query. The New Query dialog box appears.
3. Inthe upper-right corner, select Advanced Mode from the drop-down:

New Query Advancsd Mode |
Tables Student s
-~
Grade level
. Homerocom "
T2iE Home Phone
Enrcllment status
Loder B Add
Crperator Equals W
Value Source Constant  |w
Value 2012

Frompt for value F]

Search criteria

Search based on | All Active Students w

4. Atthe Tables field, select the table you want to search information in. The table you select
determines the available selections in the Fields box. For example, when you select the Stu-
dent table, fields such as Year of graduation and Last name appear.

5. AtFields, select a field you want to include in the search criteria.
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6. Atthe Operator field, select an operator. For example, to search for students with a specific year
of graduation, select the following:

7. Fields: Year of graduation
8. Operator: Equals

9. The Value Source field tells the query to either compare your Fields selection to what you enter
in the Value field, or to compare it to another value available in the system when the query is run.
Select one of the Value Source selections listed in the following table. Your selection in the
Value Source field determines the behavior of the Value field.
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Value
Source
selection

Constant

Default

Preference

Description/Function

Compares your Fields
selection to the Value you
enter, compares two
values in the same

record.

Note: Simple Mode
queries are always
Constant.

Compares your Fields
selection to a date relative
to the current date, such
as the current week, the
current year, the current
school quarter, and the
current school year.

Compares your Fields
selection to a system
preference value.

Note: The system
preferences are set up
by your Aspen
administrator.

Example

The front office
needs a list of
students
graduating in
2012 who are in
homeroom 100.

On a daily basis,
the front office
staff needs to
find all students
absent on the
current day.

A superintendent
needs a list of all
students with an
"active”
enroliment code
at the high
school. If the
high school
principal changes

Basic Navigation

Value field
Behavior

Value: Enter the
value the query is
comparing to your
Fields selection.

Prompt for value:
Select if you want the
option of changing the
value when you run
the query again.

Note: This prompt is
enabled only for
Constant and
Default value
sources.

Value: Enter the
value the query is
comparing to your
Fields selection.

Prompt for value:
Select to have the
option of changing the
value when the query
is run again.

Note: This prompt is
enabled only for
Constant and
Default value
sources.

Value: Enter the
value the query is
comparing to your
Fields selection.
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el Value field

Behavior

Source Description/Function Example
selection

the "active” code
from "A” to "E”,
this query will
continue to run
and produce
accurate results.

Compares your Fields

selection to a value from

the current system and

user session. These

values are variable, such

as the time the user

logged on, or the school Value: Enter the

S being viewed. value th_e query Is
comparing to your

R Fields selection.

Note: Using this value

source is for advanced

users, administrators,

customizations, and

support purposes.

10. If you select the Prompt for value checkbox, the following 'Search criteria' dialog box appears

11.
12.

13.

when the query is run. This gives the user the option of changing the value in the search criteria:

Search criteria

Harnaroom 1101

Year of graduation |21z

Note: If you provide a value in addition to selecting the Prompt for value checkbox, the
value will be used as a default in the 'Search criteria’ dialog box.

Click Add to add the criteria to the Search criteria box.

Click Delete if you want to delete the criteria from this search. Otherwise, you can either add
other criteria, or click Search to search for students who match the one criterion you defined.
To add other criteria, select the Table, Field, and Operator and enter the Value, if appropriate.
Then, click And or Or to determine if the students should meet the first criteria, the second cri-
teria, or both to be included in your search:
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New Query Advanced Mode |

Tables Student b

Homearcom [

Home Phone

Fields Enrcliment status

Lodkear
Woek Fhone And
Resason for Enrollment - i
Operator Egusals w
Value Source Constant | w
Value 101

Prompt for value

Search criteria

Year of graduation Equals 7[2012]
And Homercom Equals 7[101]

Search based on | All Active Students b

Basic Navigation

14. At Search based on, select the records you want to search on to determine which records are

included in this query.

15. Click Save As to save the query so you can use it again or to give other users access toit:

Name

Query
Cwmner type User -

Owner name Administrator, Joe Q
Filter

Save as filter |:|

Cwmner type

Owner name Administrator, Joe Q

Move to top of my list

Save || Cancel

16. Use the following table to fill in the fields:
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Field Description

Type a name for the query.

Name

Query Owner type

Query Owner name

Save as filter

Filter Owner type

Filter Owner name

Move to top of my list

Click this drop-down to select one of the following:

User: to give a user or yourself access to the query
School: to give users at a school access to the query

Intermediate Organization: to give all users in an inter-
mediate organization access to the query

District: to give all users in the district access to the query

Click Qa to change the owner of the query. The owner can
edit a saved query.

Select this checkbox to have this query automatically appear

on the Filter menu J/ on this page for all users who are given
access toit. If this is selected, the next three fields are
accessible.

Click this drop-down to select one of the following:

User: to give a user or yourself access to the filter
School: to give users at a school access to the filter

Intermediate Organization: to give all users in an inter-
mediate organization access to the filter

District: to give all users in the district access to the filter

Click Q to change the owner of the filter. The owner can edit
a saved filter.

Select this checkbox to have this filter appear first on your

Filter menu J/

Notes:

Including queries on your Filter menu allows you to quickly
select a group of records when you access a list page.

If a query is first on your Filter menu, it becomes your
default filter.

17. Click Save.

18. Click Search. The list page displays the records that meet your search criteria.
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Direct SQL mode queries search for records based on your own self-defined criteria, not the

system’s tables, fields, and operators. You use SQL syntax to define the criteria; therefore, you

are not limited by interface restrictions.

For example, create a Direct SQL query to search for all students who have more than one
absence this year.

To create a Direct SQL query:

A b~

Go to alist page, such as the Student List.

On the Options menu, click Query. The New Query dialog box appears.
In the upper-right corner, click the drop-down to select Direct SQL Mode.

In the box, enter the query in SQL:

New Query

Direct QL Mode -

SELECT * FROM STUDENT

WHERE STD_QID IN

(SELECT ATT_STD_OID

FROM STUDENT_ATTENDANCE
WHERE AT _DATE > '2012-09-10
AND ATT_DATE < '2013-06-30|
AND ATT_ABSENT IND = "1"
GROUP BY ATT_STD_OID
HAVING COUNT() > )

Search based cn  All Active Students

[ e J(_comsr

-

D Cache results to inorease performance

T T

[ \alidate ]
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7.

At the Search based on field, select the records you want to search on to determine which
records are included in this query.

Select the Cache results to increase performance checkbox if you want the system to cache
the results of a large query to make scrolling through the pages of results faster. Essentially, this
prevents the system from having to re-run the query each time you view another page of results.

Click Search to use the query, or Save As to save the query for future use.

Tips for entering the "Prompt for Value" token:

1.

Use brackets and the keyword "prompt" to indicate a prompted value the user will be asked for
when the query is used.

The general format for a prompt token is:

{ prompt : field ID : default type : default value : label }

When entering a prompt value for a text field, enclose the prompt with quotes just as you would
enclose a constant value in quotes.

For example: Where PSN NAME FIRST = '{prompt:

When entering a prompt for a numeric value, the prompt should not have quotes. It should appear
just as a number would in the query.

For example: Where ACT PENALTY TIME {prompt:

In general, the query should be written as if the user-entered text would be placed exactly where
the prompt command is.

SQL without SQL with

"Prompt for Value" field "Prompt for Value" field

SELECT * FROM STUDENT
SELECT * FROM STUDENT

WHERE STD HOMEROOM = '

WHERE STD HOMEROOM = ’"101’
- {prompt:
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SQL Syntax for... Function

Prompt « Constant, must be "prompt"

« Data Dictionary ID for a field

« Determines the type of value to be retrieved and the label
to appear before the prompt

« Field ID can also be one of the following constants and
will result in an appropriate input for the type:

Text: Input field for text
Character: Input field for text

Integer: Input field for an integer
Field ID
Number: Input field for a number. Decimal places are
allowed.

Date: Input field for a date, with date picker
Time: Input field for a time value

Logical: Checkbox field. This field will produce a zero (0) or
one (1) in the generated SQL, which is appropriate for all
logical database fields. It might not correspond to other
Boolean operations in SQL.

« Type of default value that should appear in the prompt
screen.

« Allows users to keep this value or replace it with their own.

« Can be blank if there is no default; or can be either const or
default.

« See the following table on Default type = default.

Default type (optional)

« Default value to appear in the field’'s prompt.

Default value (optional) . If default type is const, this is a suitable input value for
comparison.

Note: Default type and Default value can be left empty if they are not needed, but their
positions should be marked with a colon ( : ) if the label is used and they are not.

« Label displays when user is prompted for input value.

Label (optional) . Ifthis is not present, the label will come from the user label
on the field Id.
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When Default type = default, a relevant value is looked up and placed as the Default
value:

Default Value Function

today current date

now current date (same as "today")
districtYearEnd last day of district school year
districtYearStart first day of district school year
firstOfMonth first day of current month
firstOfWeek first day of current week
lastOfMonth last day of current month
currentGradeTerm current grade term
schoolStartGrade school start grade
schoolEndGrade school end grade

Examples of prompt commands in SQL.:
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Prompt Function

« prompts for homeroom value with

rompt : stdHomeroom .
p - } label from homeroom field

o prompts forlast name

{prompt:psnlastName: « include the default of "Jones" when
prompting user

« prompts for date of birth

{prompt:psnDob:default:today} « displays the default value of current

day
{prompt:psnEmailOl:::Main Email « prompts for an email address
Address}

« use the label "Main Email Address"
in prompt entry screen

{prompt:Text:const:Mary:Student
first name} » prompts with field for text entry

« default with value and label

{prompt:Date:default:today} « prompts with field for date entry
« default value for today

Understanding Queries, Snapshots, and Filters

Queries, snapshots, and filters are ways to filter any list, such as the Student List or the Staff List.
Query

A query is a dynamic filter. Use a query to search for a group of records one time. If you use the
same query criteria again, it might not produce the same list of records. For example, you can use
a query to search for all ninth-graders who have a GPA equal to or higher than 3.0. Because a
student's GPA can change with each grade term, the group of students that the query gathers
could be different each time you use it.

Snapshot

A snapshot represents a static filter. Use a snapshot to take a picture of a group of records you will
need to access regularly, or need to save. For example, assume you want to save the group of
students the query above finds to determine your Quarter 1 Honor Roll. Once you create the
snapshot — think of a picture taken with a camera — the group of students in the snapshot never
changes.

Therefore, if you create a snapshot of students in your homeroom today, and a new student
registers tomorrow, your snapshot does not contain that new student. But you can modify a
snapshot manually.

Filters
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There are default filters and custom filters. Default filters are available from every list page. You can
also create your own filters when you make a snapshot or query. You have the option of saving a
snapshot and a query as a filter so you can use it again. You will be able to easily access the filter

by clicking ? and selecting the filter you created to view the list of records.

Use, Copy, Edit, and Delete Saved Queries

Queries help you search for and filter a group of records that matches specific criteria at a particular
time. Your Aspen system administrator has most likely created a number of queries for your district.

To use, copy, edit, or delete a saved query:

1. Gotoalist page, such as the Student List.
2. On the Options menu, click Query. The New Query dialog box appears:

New Query Simple Mode
Tables | Student v |
2
Home Phone =
Enrcliment status —
i Sort A-Z
Fields Lodeer

Weork Phone

Reascn for Enrollment

L
Operator | Egquals W |
Value [101
Search criteria
Delete
(-
Search based on | All Active Students W

[ sesrch || Cancel |

[Mew|| Savess. || Select.
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3. Click Select. The Query Pick List appears:

g | 1: 1 student per Phone, Address

v|[?] 28 records 7

Name

OwnerlType

1 student per Phone, Address

Dvistrict

2010 YoG

User

Active SFED Students

District

Begins with a

Counselor = Mr. Jones

Scheol

Counselor = Mr. Owens

Scheol

Counselor = Ms. Adler

School

Counselor = Ms. Parker

School

Counselor = Ms. Reyes

School

Female 10th Grade

O|0|0|0[|0|0|0|0|0|®

4. Select the query you want to use.
5. Do one of the following:

« Click Use to run the query, then click Search.

« Click Copy to use the saved query as a shell to create a new one. Change the query name,
owner type, and owner name as needed. Click Save.

« Click Edit to change the query name, owner type, and owner name. Then click Save. The
edits made apply to all users who have access to this query.

Click Delete to remove the query. The query will be deleted from the Filter menu ?

of all users who have access to it.

If you are using a saved Advanced or Direct SQL query and Prompt for value had been selec-

ted, the 'Search criteria’ dialog box appears:
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Search criteria

Homeroom |01

‘ear of gradustion 12012

Close

7. Enter the search criteria, and click Submit. The list page displays the records that meet your
search criteria

Name Advanced and SQL Queries

For queries that have prompts, it is helpful to have the query name include the value that the user
entered. To do so, when you save the query, include a question mark (?) within its name.

Example: Homeroom ?

A user who selects this query is prompted to enter values for each prompt. After values are entered
and the query is run, the new filter appears on the query list with the value the user entered in place
of the question mark.

For example, the user is prompted for a homeroom. He enters 101. After running the query, the list
displays students in homeroom 101 and the filter name on the page is now Homeroom 101. The
question mark in the query name is replaced by 101.

Create Parenthesized Queries

In Simple and Advanced modes, you can also create parenthesized queries to manage and group
complex search conditions. Parentheses allow you to group criteria, resulting in a more powerful
search tool.

With a parenthesized query, a single search produces results that would require multiple queries
using the basic method.

For example, you can search for records that meet one of the following two conditions:

« all females who are in homeroom 287; or
« all females who are in homeroom 360;

and one of the following two conditions:

« whose graduation year is 2010; or
« whose graduation year is 2011.

Using a basic query, this same search would require three separate queries.
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To create a parenthesized query:

Go to alist page, such as the Student List.

On the Options menu, click Query. The New Query dialog box appears.
Enter your first criteria, such as Gender equals female.

Click Add to add the criteria to the Search criteria box.

Enter your next criteria, such as Homeroom equals 101.

I A

Click And or Or to determine if students should meet the first criteria and the second criteria, or
the first criteria or the second criteria.

Enter your next criteria, such as Homeroom equals 151.

~

8. Click to highlight the criteria that you want to put in parentheses, such as the homeroom lines.

9. Under Delete, click the Parentheses button to put these criteria in parentheses:
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Advanced Mode W

New Query

Tables Student W

Homeroom I\

Home Phone

Enrcliment status

Lodker
Wodk Phone —
Reason for Enrollment W o
Cperator Eguals W
Value Source Constant W
Value 181

Prompt for value I:l

Search criteria

Gender Equals F

And { Homercom Equals 101

Or Homeroom Equals 151 ) m

Search based on | All Active Students W

[NE-.'.'][ Save As... ][ Seledt... ]

[ Search ] [ Cancel ]

10. Click And or Or to tell the system how you want it to handle the next criteria you enter in relation
to the previous one.
11. Enter your next set of criteria, as you did in steps 6-8.

12. To nest this set of criteria, select the lines to highlight them and click :
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New Query Advanced Mode |+
Tables | Student W |
“fear of graduation s
Grade level =
Homercom Bl
i Sort A-Z
Fields Home Phone
Enraliment status o
Lodeer A el
Operator | Eguals W |
Value Source
Value 2011 |
Prompt for value |:|
Search criteria
Gender Equals F
And { Homerocom Equals 101
Or Homeroom Equals 151 )
And { Year of graduation Equals 2010
O Year of graduation Equals 2011 )
Search based on | All Adctive Students W
[ Search ][ Cancel ] [NE‘-.'.'][ Save As... ][ Seled... ]

13. At Search based on, select the records you want to search on to determine which records are
included in this query.

14. If you want to save the query to use it again, click Save As and enter the information.
15. Click Search. The list page displays the records that meet your search criteria:

Student List
Btads 0 of 8 selected (7 Cusfom Selection
Bk [ {name Address LASID YOG |DOB Grade |Hrm |Counselor
[ |Atien, Kendss Lynn 3 Bassett 034070 2010  [8/14/1989 10 380 |Mrs. D. Boland
Attendance [ |careire, Jennifer Anita 4 Pond Street 158451  |2010 |a/8r1890 10 287 |Mr. G. Andrade
Conduct []|carter, Veronics Les 82 Coggeshell 179988 2011 |8/2/1990 11 380 |Ms. B. Martin
[ |Fem=irz, Videriz 316 Johnson Street 35D 377751 (2010 [7/2/1990 10 380  |Mrs. E. Sabra
D Gagnon, Kuntheanita Lyn 34 Tremont Strest 774835 2010 [2/21/1980 10 380 Mr. G. Andrade
[ |kheng, Kiers 9 Penny Fond 188773 (2011  (3/18/1388 1 287 |Ms.P. Farias
[]|Pereira, marissa 44 Main Strest 732853 (2010 [10/21/1880 10 380 (M. M. Rotondo
A []|seencer, Tiftani 484 Main St 3rd 353256 2010  |BM7/1990 10 380  |Mr. R. Comeira
Membership

Getting Help

Following are some ways to get help with using Aspen:
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« Usethe Help menu

« Report a problem to your IT Department

« Recover your password

Use the Help Menu

Go to the Help menu to access information that will make using Aspen easier and more efficient.
When you have a question about how to do something in the system, come to this menu first:

Pages w Student  Staff Attendance Conduct Grades

Options Reports Help

COnline Help
School Setup Release Notes -
[ User Guides [
Quidk Reference Cards  »
SE;:E”E Videos & Training Tools
N 1] ik Report a Problem Type |Lewel StartGrade I
|:| 4125700 C About Azpen HS High school ] b
Guided Tasks

The Help menu contains the following options:

« Online Help: Click to view an online help system with instructions on how the system is set up
and ways to perform common tasks. A table of contents, index, and search feature make it easy
to find the information you need.

« Release Notes: Click to view a list of major changes and new features that have been added to
the system in recent releases.

« User Guides: Click to open a PDF version of all of the Aspen user guides, such as Basic Nav-
igation and Managing Students. Refer to and print these as needed. They are updated with each
release.

« Quick Reference Cards: Click to access sheets on guided steps or summaries of the most
common tasks used. They provide a good refresher after attending a training or a quick way to
look up a frequently used feature or process.

« Videos & Training Tools: Click to access training toolkits designed to help you learn and teach
others about specific features in Aspen. Each toolkit provides a comprehensive overview of one
aspect of Aspen using a variety of training materials, including lesson plans, videos, and quick
reference guides.

« Report a Problem: If your district uses the feature and you have appropriate privileges, the
"Report a Problem" option appears. Click to report a problem to your district’s IT department.

« About Aspen: Click to view which version of the system you are currently using.

Report a Problem to Your IT Department

If your district enables ticket reporting and you have appropriate security privileges, you can report a
problem to your IT department directly from Aspen.
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To report a problem to your IT department:

1. Onany page in the system, click the Help menu.
2. Click Report a Problem. The Report a Problem dialog box appears:

Report a Problem

Log a support ticket using the form below

Summary leving trouble printing to science departrment printer
Computer 10 SC101A
Location On Campus v-
Category Mon-application |
Detail W |
'P:inting to science ﬂepaxtment printer 'ﬁangs'

Description

3. Enter the information the IT department will need to solve your problem.

4. Click Submit. This ticket is submitted to Pando, the system the IT department uses to manage
Aspen and computer issues in your district.

You are automatically entered as the contact for the issue. When an IT staff member makes
changes or progress on your issue, an email is sent to the email address entered when you set.
your user preferences.

Recover Your Password

If you forget your password and automatic password recovery has been set up on your system,
you can retrieve it from the Log On page.

To recover your password:

On the Log On page, click | forgot my password. The Password Reset dialog box appears.
2. Enteryour Login ID and Primary email address.

3. Click Continue. The Password Reset dialog box expands to include the security question you
chose when setting up password recovery.

4. Type the response, and click Submit. If the answer is correct, Aspen sends a message con-
taining your password to your primary email address.
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